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Introduction

Read this book if you are new to COMSOL Multiphysics®. It provides an 
overview of the COMSOL® environment with examples that show you how to use 
the COMSOL Desktop® user interface and the Model Builder. It also provides a 
quick introduction to creating applications using the Application Builder.
If you have not yet installed the software, install it now according to the 
instructions at www.comsol.com/product-download.
In addition to this book, an extensive documentation set is available after 
installation. Tutorials can be found throughout the COMSOL website, including 
in the Video Gallery at www.comsol.com/videos and in the COMSOL Blog at 
www.comsol.com/blogs.
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COMSOL Desktop®

MODEL BUILDER—The Model 
Builder window with its model 
tree and the associated toolbar 
buttons gives you an overview of 
the model. The modeling 
process can be controlled from 
context-sensitive menus 
accessed by right-clicking a node.

MODEL BUILDER 
TOOLBAR

QUICK ACCESS TOOLBAR—Use these 
buttons for access to functionality such as file 
open/save, undo/redo, copy/paste, and delete.

RIBBON—The ribbon tabs have buttons 
and drop-down lists for controlling all 
steps of the modeling process.

MODEL TREE—The model 
tree gives an overview of the 
model and all the functionality 
and operations needed for 
building and solving a model as 
well as processing the results.

SETTINGS WINDOW—Click 
any node in the model tree to 
see its associated Settings 
window displayed next to the 
Model Builder.

APPLICATION BUILDER—
Click this button to switch to 
the Application Builder and 
start building an application 
based on your model.
6 | 
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mo
pro
GRAPHICS WINDOW—The Graphics window presents 
interactive graphics for the Geometry, Mesh, and Results 
nodes. Operations include rotating, panning, zooming, and 
selecting. 

GRAPHICS WINDOW TOOLBAR

FORMATION WI1NDOWS—The Information windows will display vital 
del information during the simulation, such as the solution time, solution 
gress, mesh statistics, solver logs, and, when available, results tables.
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The screenshot on the previous pages is what you will see when you first start 
modeling in COMSOL Multiphysics using the Model Builder. COMSOL 
Desktop® provides a complete and integrated environment for physics modeling 
and simulation as well as application design, providing you with the tools necessary 
to build a user-friendly interface for your models. You can customize the desktop 
to your own needs. The windows can be resized, moved, docked, and detached. 
Any changes you make to the layout will be saved when you close the session and 
available again the next time you open COMSOL Multiphysics. As you build your 
model, additional windows and widgets will be added. (See page 24 for an 
example of a more developed desktop.) Among the available windows and user 
interface components are the following:

Quick Access Toolbar

The Quick Access Toolbar gives access to functionality such as Open, Save, Undo, 
Redo, Copy, Paste, and Delete. You can customize its content from the 
Customize Quick Access Toolbar list.

Ribbon

The ribbon at the top of the desktop gives access to commands used to complete 
most modeling tasks. The ribbon is only available in the Windows® version of the 
COMSOL Desktop environment and is replaced by menus and toolbars in the 
OS X and Linux® versions. Click the Application Builder button to switch from 
the Model Builder to the Application Builder and start building an application 
based on your model.

Settings Window

This is the main window for entering all of the specifications of the model 
including the dimensions of the geometry, properties of the materials, boundary 
conditions and initial conditions, and any other information that the solver will 
8 | 



need to carry out the simulation. The picture below shows the Settings window 
for the Geometry node.

Plot Windows

These are the windows for graphical output. In addition to the Graphics window, 
Plot windows are used for visualizing results. Several Plot windows can be used to 
show multiple results simultaneously. A special case is the Convergence Plot 
window, an automatically generated Plot window that displays a graphical 
indication of the convergence of the solution process while a model is running.

Information Windows

These are the windows for non-graphical information. They include:
• Messages: Various information about the current COMSOL session is 

displayed in this window.
• Progress: Progress information from the solver in addition to stop buttons.
• Log: Information from the solver such as number of degrees of freedom, 

solution time, and solver iteration data.
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• Table: Numerical data in table format as defined in the Results branch.
• External Process: Provides a control panel for cluster, cloud, and batch jobs.

Other Windows

• Add Material and the Material Browser: Access the material property 
libraries. The Material Browser enables editing of material properties.

• Selection List: A list of geometry objects, domains, boundaries, edges, and 
points that are currently available for selection.

The Windows drop-down list in the Home tab of the ribbon gives you access 
to all COMSOL Desktop windows. (On OS X and Linux®, you will find this in 
the Windows menu.)

Progress Bar with Cancel Button

The Progress Bar with a button for canceling the current computation, if any, is 
located in the lower right-hand corner of the COMSOL Desktop interface.

Dynamic Help

The Help window provides context-dependent help texts about windows and 
model tree nodes. If you have the Help window open in your desktop (by typing 
F1, for example), you will get dynamic help (in English only) when you click a 
node or a window. From the Help window you can search for other topics such 
as menu items.

The Model Builder and the Application Builder

The two main components of the COMSOL Desktop environment are the Model 
Builder and the Application Builder.
The Model Builder is the tool where you define the model and its components: 
how to solve it, the analysis of results, and the reports. You do that by building a 
model tree. The model tree reflects the underlying data structure, the model 
object, which stores the state of the model including settings for: geometry, mesh, 
physics, boundary conditions, studies, solvers, postprocessing, and visualizations. 
The Application Builder allows you to quickly create an application with a 
specialized user interface that is easy to use. An application is based on a model 
created with the Model Builder. The Application Builder provides two important 
tools for creating applications: The Form editor and the Method editor. In 
addition, an application can have a menu bar or a ribbon. The Form editor 
includes drag-and-drop capabilities for easily accessing and including user 
10 | 



interface components such as input fields, graphics windows, and buttons. The 
Method editor is a programming environment that allows you to modify the 
model represented by the model object data structure.
This book, Introduction to COMSOL Multiphysics, gives a detailed introduction 
to using the Model Builder and a quick introduction to the Application Builder. 
For detailed information on how to use the Application Builder, see Introduction 
to Application Builder.

Running Applications and COMSOL Server

The Application Builder is included in the Windows® version of COMSOL 
Multiphysics. With a COMSOL Multiphysics license, applications can be run from 
the COMSOL Desktop. With a COMSOL Server license, applications can be run 
in major web browsers on a variety of operating systems and hardware platforms. 
In addition, you can run applications by connecting to COMSOL Server with an 
easy-to-install COMSOL Client for Windows®.
The COMSOL Client for Windows® allows a user to run applications that require 
a LiveLink™ product for CAD.
Running applications in a web browser does not require any installation and no 
web browser plug-ins are needed. Running an application in a web browser 
supports interactive graphics in 1D, 2D, and 3D. In a web browser, graphics 
rendering in 3D is based on WebGL™ technology which comes included with all 
major web browsers.
To create an application based on your model, use 
the Application Builder, accessible from the Home 
tab in the ribbon.
For more information on creating a COMSOL 
application, refer to the section “Creating an 
Application using the New Form Wizard” on page 
82 and the book Introduction to Application Builder.
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Preferences

Preferences are settings that affect the modeling environment. Most are persistent 
between modeling sessions, but some are saved with the model. You access 
Preferences from the File menu.

In the Preferences window, you can change settings such as graphics rendering, 
number of displayed digits for results, maximum number of CPU cores used for 
computations, or paths to user-defined application libraries. Take a moment to 
browse your current settings to familiarize yourself with the different options.
There are three graphics rendering options available: OpenGL®, DirectX®, and 
Software Rendering. DirectX® is not available in OS X or Linux®, but is available 
in Windows® if you choose to install the DirectX® runtime libraries during 
installation. If your computer does not have a dedicated graphics card, you may 
have to switch to Software Rendering for slower but fully functional graphics. A 
list of recommended graphics cards can be found at:

www.comsol.com/system-requirements
12 | 
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Creating a New Model

You can set up a model guided by the Model Wizard or start from a Blank Model 
as shown in the figure below. 

CREATING A MODEL GUIDED BY THE MODEL WIZARD

The Model Wizard will guide you in setting up the space dimension, physics, and 
study type in a few steps:
1 Start by selecting the space dimension for your model component: 3D, 2D 

Axisymmetric, 2D, 1D Axisymmetric, or 0D.

2 Now, add one or more physics interfaces. These are organized in a number of 
Physics branches in order to make them easy to locate. These branches do not 
directly correspond to products. When products are added to your COMSOL 
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Multiphysics installation, one or more branches will be populated with 
additional physics interfaces.
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3 Select the Study type that represents the solver or set of solvers that will be used 
for the computation.

Finally, click Done. The desktop is now displayed with the model tree 
configured according to the choices you made in the Model Wizard.

CREATING A BLANK MODEL

The Blank Model option will open the COMSOL Desktop interface without any 
Component or Study. You can right-click the model tree to add a Component of 
a certain space dimension, a physics interface, or a Study.

The Ribbon and Quick Access Toolbar

The ribbon tabs in the COMSOL Desktop environment reflect the modeling 
workflow and give an overview of the functionality available for each modeling 
step, including building simulation applications from your models.

The Home tab contains buttons for the most common operations for making 
changes to a model, running simulations, and for building and testing 
applications. Examples include changing model parameters for a parameterized 
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geometry, reviewing material properties and physics, building the mesh, running 
a study, and visualizing the simulation results.
There are standard tabs for each of the main steps in the modeling process. These 
are ordered from left to right according to the workflow: Definitions, Geometry, 
Materials, Physics, Mesh, Study, and Results.
Contextual tabs are shown only if and when they are needed, such as the 3D Plot 
Group tab, which is shown when the corresponding plot group is added or when 
the node is selected in the model tree.

Modal tabs are used for very specific operations, when other operations in the 
ribbon may become temporarily irrelevant. An example is the Work Plane modal 
tab. When working with Work Planes, other tabs are not shown since they do not 
present relevant operations.

THE RIBBON VS. THE MODEL BUILDER

The ribbon gives quick access to available commands and complements the model 
tree in the Model Builder window. Most of the functionality accessed from the 
ribbon is also accessible from contextual menus by right-clicking nodes in the 
model tree. Certain operations are only available from the ribbon, such as selecting 
which desktop window to display. In the COMSOL Desktop interface for OS X 
and Linux®, this functionality is available from toolbars, which replace the ribbon 
on these platforms. There are also operations that are only available from the 
model tree, such as reordering and disabling nodes.

THE QUICK ACCESS TOOLBAR

The Quick Access Toolbar contains a set of commands that are independent of the 
ribbon tab that is currently displayed. You can customize the Quick Access 
Toolbar; you can add most commands available in the File menu, commands for 
undoing and redoing recent actions, for copying, pasting, duplicating, and 
deleting nodes in the model tree. You can also choose to position the Quick 
Access Toolbar above or below the ribbon.
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OS X AND LINUX®

In the COMSOL Desktop environment for OS X and Linux®, the ribbon is 
replaced by a set of menus and toolbars:

The instructions in this book are based on the Windows® version of the COMSOL 
Desktop environment. However, running COMSOL in OS X and Linux® is very 
similar, keeping in mind that ribbon user interface components can instead be 
found in the corresponding menus and toolbars.

The Model Builder and the Model Tree

Using the Model Builder, you build a model by starting with the default model 
tree, adding nodes, and editing the node settings.
All of the nodes in the default model tree are top-level parent nodes. You can 
right-click on them to see a list of child nodes, or subnodes, that you can add 
beneath them. This is the means by which nodes are added to the tree.
When you click on a child node, then you will see its node settings in the Settings 
window. It is here that you can edit node settings.
It is worth noting that if you have the Help window open (which is achieved either 
by selecting Help from the File menu, or by pressing the function key F1), then 
you will also get dynamic help (in English only) when you click on a node.

THE ROOT, GLOBAL DEFINITIONS, AND RESULTS NODES

A model tree always has a root node (initially 
labeled Untitled.mph), a Global Definitions 
node, and a Results node. The label on the root 
node is the name of the multiphysics model file, 
or MPH file, that this model is saved to. The 
root node has settings for author name, default 
unit system, and more.
The Global Definitions node has a Materials 
subnode by default. The Global Definitions node is where you define parameters, 
variables, functions, and couplings that can be used throughout the model tree. 
They can be used, for example, to define the values and functional dependencies 
of material properties, forces, geometry, and other relevant features. The Global 
Definitions node itself has no settings, but its child nodes have plenty of them. The 
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Global Definitions>Materials node stores material properties that can be 
referenced in the Component nodes of a model.
The Results node is where you access the solution after performing a simulation 
and where you find tools for processing the data. The Results node initially has 
five subnodes:
• Data Sets, which contain a list of solutions 

you can work with.
• Derived Values, which defines values to be 

derived from the solution using a number 
of postprocessing tools.

• Tables, which is a convenient destination 
for the Derived Values or for Results 
generated by probes that monitor the 
solution in real-time while the simulation is 
running.

• Export, which defines numerical data, 
images, and animations to be exported to files.

• Reports, which contains automatically generated or custom reports about 
the model in HTML or Microsoft® Word® format.

To these five default subnodes, you may also add more Plot Group subnodes that 
define graphs to be displayed in the Graphics window or in Plot windows. Some 
of these may be created automatically, depending on the type of simulations you 
are performing, but you may include additional figures by right-clicking on the 
Results node and choosing from the list of plot types.

THE COMPONENT AND STUDY NODES

In addition to the three nodes just described, 
there are two additional top-level node types: 
Component nodes and Study nodes. These are 
usually created by the Model Wizard when you 
create a new model. After using the Model 
Wizard to specify what type of physics you are 
modeling and what type of Study (e.g., 
steady-state, time-dependent, 
frequency-domain, or eigenfrequency analysis) you will carry out, the Wizard 
automatically creates one node of each type and shows you their contents.
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It is also possible to add more 
Component and Study nodes as you 
develop the model. A model can 
contain multiple Component and 
Study nodes and it would be 
confusing if they all had the same 
name. Therefore, these types of 
nodes can be renamed to be 
descriptive of their individual 
purposes. 
If a model has multiple Component 
nodes, they can be coupled to form a 
more sophisticated sequence of 
simulation steps.
Note that each Study node may carry 
out a different type of computation, 
so each one has a separate Compute  
button .
To be more specific, suppose that you build a model that simulates a coil assembly 
that is made up of two parts, a coil and a coil housing. You can create two 
Component nodes, one that models the coil and the other the coil housing. You 
can then rename each of the nodes with the name of the object. Similarly, you can 
also create two Study nodes, the first simulating the stationary or steady-state 
behavior of the assembly, and the second simulating the frequency response. You 
can rename these two nodes to be Stationary and Frequency Domain. When the 
model is complete, save it to a file named Coil Assembly.mph. At that point, the 
model tree in the Model Builder looks like the figure below.
In this figure, the root node is named Coil 
Assembly.mph, indicating the file in which the 
model is saved. The Global Definitions node 
and the Results node each have their default 
name. Additionally, there are two Component 
nodes and two Study nodes with the names 
chosen in the previous paragraph.

Keyboard Shortcuts
Keyboard Shortcuts
 | 19



PARAMETERS, VARIABLES, AND SCOPE

Parameters
Parameters are user-defined constant scalars that are usable throughout the model. 
That is to say, they are “global” in nature. Important uses are:
• Parameterizing geometric dimensions.
• Specifying mesh element sizes.
• Defining parametric sweeps (that is, simulations that are repeated for a 

variety of different values of a parameter such as a frequency or a load).

A parameter expression can contain numbers, parameters, built-in constants, 
built-in functions with parameter expressions as arguments, and unary and binary 
operators. For a list of available operators, see “Appendix C—Language Elements 
and Reserved Names” on page 155. Because these expressions are evaluated 
before a simulation begins, parameters may not depend on the time variable t. 
Likewise, they may not depend on spatial variables like x, y, or z, nor on the 
dependent variables that your equations are solving for.
It is important to know that the names of parameters are case sensitive.
You define Parameters in the model tree under Global Definitions.

Variables
Variables can be defined either in the Global Definitions node or in the Definitions 
subnode of any Component node. Naturally, the choice of where to define the 
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variable depends on whether you want it to be global (that is, usable throughout 
the model tree) or locally defined within a single Component node. Like a 
Parameter Expression, a Variable Expression may contain numbers, parameters, 
built-in constants, and unary and binary operators. However, it may also contain 
Variables like t, x, y, or z; functions with Variable Expressions as arguments; and 
dependent variables that you are solving for in addition to their space and time 
derivatives.

Variables Used in Applications
Model parameters and variables can be used in applications. For example, you can 
let the user of an application change the value of a parameter. In addition, variables 
to be used in applications can be defined in the Application Builder under the 
Declarations node.

Scope
The “scope” of a Parameter or Variable is a statement about where it may be used 
in an expression. All Parameters are defined in the Global Definitions node of the 
model tree. This means that they are global in scope and can be used throughout 
the model tree.
A Variable may also be defined in the Global Definitions node and have global 
scope, but they are subject to other limitations. For example, Variables may not 
be used in Geometry, Mesh, or Study nodes (with the one exception that a 
Variable may be used in an expression that determines when the simulation should 
stop).
A Variable that is defined, instead, in the Definitions subnode of a Component 
node has local scope and is intended for use in that particular Component (but, 
again, not in Geometry or Mesh nodes). They may be used, for example, to specify 
material properties in the Materials subnode of a Component or to specify 
boundary conditions or interactions. It is sometimes valuable to limit the scope of 
the variable to only a certain part of the geometry, such as certain boundaries. For 
that purpose, provisions are available in the settings for a Variable to select 
whether to apply the definition either to the entire geometry of the Component, 
or only to certain Domains, Boundaries, Edges, or Points.
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The figure at left shows the definition 
of two Variables, q_pin and R, for 
which the scope is limited to just two 
boundaries identified by numbers 15 
and 19.
Such Selections can be named and then 
referenced elsewhere in a model, such 
as when defining material properties or 
boundary conditions that will use the 
Variable. To give a name to the 
Selection, click the Create Selection 
button ( ) to the right of the 
Selection list.
Although Variables defined in the 
Definitions subnode of a Component 
node are intended to have local scope, 
they can still be accessed outside of the 
Component node in the model tree by 
being sufficiently specific about their 
identity. This is done by using a 
“dot-notation” where the Variable 

name is preceded by the name of the Component node in which it is defined and 
they are joined by a “dot”. In other words, if a Variable named foo is defined in a 
Component node named MyModel, then this variable may be accessed outside of 
the Component node by using MyModel.foo. This can be useful, for example, 
when you want to use the variable to make plots in the Results node. Variables 
defined under the Declarations node in the Application Builder are available 
globally in form objects and methods but cannot be used in the Model Builder.

Built-In Constants,  Variables,  and Functions

COMSOL Multiphysics comes with many built-in constants, variables, and 
functions. They have reserved names that cannot be redefined by the user. If you 
use a reserved name for a user-defined variable, parameter, or function, the text 
you enter will turn orange (a warning) or red (an error) and you will get a tooltip 
message if you select the text string.
Some important examples are:
• Mathematical constants such as pi (3.14...) or the imaginary unit i or j
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• Physical constants such as g_const (acceleration of gravity), c_const (speed 
of light), or R_const (universal gas constant)

• The time variable, t
• First-and-second-order derivatives of the Dependent variables (the solution) 

whose names are derived from the spatial coordinate names and Dependent 
variable names (which are user-defined variables)

• Mathematical functions such as cos, sin, exp, log, log10, and sqrt

See “Appendix C—Language Elements and Reserved Names” on page 155 for 
more information.
.The following spread shows an example of a customized desktop with additional 
windows.
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SETTINGS WINDOW

MODEL BUILDER 
WINDOW

MODEL TREE

PLOT WINDOW—The Plot window is used to visualize Results 
quantities, probes, and convergence plots. Several Plot windows 
can be used to show multiple results simultaneously.

QUICK ACCESS 
TOOLBAR

RIBBON
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DYNAMIC HELP—Continuously updated with online access to the 
Knowledge Base and Application Gallery. The Help window enables 
easy browsing with extended search functionality.

PROGRESS BAR WITH CANCEL BUTTON

GRAPHICS WINDOW

INFORMATION WINDOWS
 | 25



The Application Libraries

The Application Libraries are collections of MPH files containing tutorial models 
and runnable applications with accompanying documentation. Tutorial models 
have documentation that includes the theoretical background and step-by-step 
instructions. Runnable applications have instructions on how to use the 
application. You can readily edit all tutorial models and applications to make them 
your own. Each physics-based add-on module comes with its own application 
library with examples specific to its applications and physics area. You can use the 
step-by-step instructions and the MPH files as a template for your own modeling. 
To open the Application Libraries window, on the Home toolbar, Windows menu 
select Application Libraries  or select File>Application Libraries  and then 
search by application name or browse under a module folder name. 

Click Open Application , Run Application , or Open PDF Document . 
Alternatively, select File>Help>Documentation in COMSOL Multiphysics to 
search by application name or browse by module. Note that the Run Application 
option is only available for MPH files that are runnable applications.
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The MPH files in the COMSOL Application Library can have two formats—Full 
MPH files or Compact MPH files:
• Full MPH files, including all meshes and solutions. In the Application 

Libraries window, these appear with the  icon. If the MPH file’s size 
exceeds 25MB, a tip with the text “Large file” and the file size appears when 
you position the cursor at the model’s node in the Application Libraries tree.

• Compact MPH files with all settings for the model but without built meshes 
and solution data to save space on the DVD (a few MPH files have no 
solutions for other reasons). You can open these to study the settings and to 
mesh and re-solve the applications. It is also possible to download the full 
versions—with meshes and solutions—of most of these when you update 
your Application Library. These appear in the Application Libraries window 
with the  icon. If you position the cursor at a compact file in the 
Application Libraries window, a “No solutions stored” message appears. If a 
full MPH file is available for download, the corresponding node’s context 
menu includes a Download File with Solutions  option. 

The Application Libraries are updated on a regular basis by COMSOL. To check 
all available updates, select Update COMSOL Application Library  from the 
File>Help menu (Windows® users) or from the Help menu (OS X and Linux® 
users). This connects you to the COMSOL website where you can access new 
applications and the latest updates.
 | 27



Workflow and Sequence of Operations

In the Model Builder window, every step of the modeling process, from defining 
global variables to the final report of results, is displayed in the model tree.

From top to bottom, the model tree defines an orderly sequence of operations.
In the following branches of the model tree, the node order makes a difference 
and you can change the sequence of operations by moving the subnodes up or 
down the model tree:
• Geometry
• Materials
• Physics
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• Mesh
• Study
• Plot Groups

In the Component Definitions branch of the tree, the ordering of the following 
node types also makes a difference:
• Perfectly Matched Layer
• Infinite Elements

Nodes may be reordered by these methods:
• Drag-and-drop
• Right-clicking the node and selecting Move Up or Move Down
• Pressing Ctrl + up-arrow or Ctrl + down-arrow
In other branches, the ordering of nodes is not significant with respect to the 
sequence of operations, but some nodes can be reordered for readability. Child 
nodes to Global Definitions is one such example.
You can view the sequence of operations presented as program code statements by 
saving the model as a model file for MATLAB® or as a model file for Java® after 
having selected Compact History in the File menu. Note that the model history 
keeps a complete record of the changes you make to a model as you build it. As 
such, it includes all of your corrections including changes to parameters and 
boundary conditions and modifications of solver methods. Compacting this 
history removes all of the overridden changes and leaves a clean copy of the most 
recent form of the model steps. You can also use the Record a New Method option 
to view and edit program code statements in the Method editor of the Application 
Builder. 
As you work with the COMSOL Desktop interface and the Model Builder, you 
will grow to appreciate the organized and streamlined approach. But any 
description of a user interface is inadequate until you try it for yourself. So, in the 
next chapters, you are invited to work through two examples to familiarize 
yourself with the software.
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Example 1: Structural Analysis of a Wrench

This simple example requires none of the add-on products to COMSOL 
Multiphysics®. For more fully-featured structural mechanics models, see the 
Structural Mechanics Module application library.
At some point in your life, it is likely that you have tightened a bolt using a wrench. 
This exercise takes you through a structural mechanics model that analyzes this 
basic task from the perspective of the structural integrity of the wrench subjected 
to a worst-case loading.
The wrench is, of course, made from steel, a ductile material. If the applied torque 
is too high, the tool will be permanently deformed due to the steel’s elastoplastic 
behavior when pushed beyond its yield stress level. To analyze whether the wrench 
handle is appropriately dimensioned, you will check if the mechanical stress level 
is within the yield stress limit.
This tutorial gives a quick introduction to the COMSOL workflow. It starts with 
opening the Model Wizard and adding a physics option for solid mechanics. Then 
a geometry is imported and steel is selected as the material. You then explore the 
other key steps in creating a model by defining a parameter and boundary 
condition for the load, selecting geometric entities in the Graphics window, 
defining the Mesh and Study, and finally examining the results numerically and 
through visualization.
If you prefer to practice with a more advanced model, read this section to 
familiarize yourself with some of the key features, and then go to the tutorial 
“Example 2: The Busbar—A Multiphysics Model” on page 53. 
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Model Wizard

1 To start the software, double-click the COMSOL icon on 
the desktop, which will take you to the New window with 
two options for creating a new model: Model Wizard or 
Blank Model.

If you select Blank Model, you can right-click the root 
node in the model tree to manually add a Component and 
a Study. For this tutorial, click the Model Wizard button.
If COMSOL is already open, you can start the Model 
Wizard by selecting New from the File menu. Choose the 
Model Wizard.

The Model Wizard will guide you through the first steps of 
setting up a model. The next window lets you select the 
dimension of the modeling space.

2 In the Select Space Dimension window, select 3D.

3 In Select Physics, select Structural 
Mechanics > Solid Mechanics 
(solid) . Click Add.
Without add-on modules, Solid 
Mechanics is the only physics interface 
available in the Structural Mechanics 
folder. In the picture to the right, the 
Structural Mechanics folder is shown as 
it appears when all add-on modules are 
available.

Click Study  to continue.
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4 Click Stationary  under Preset 
Studies. Click Done  once you have 
finished.
Preset Studies have solver and equation 
settings adapted to the selected physics; 
in this example, Solid Mechanics. A 
Stationary study is used in this case—
there are no time-varying loads or 
material properties.
Any selection from the Custom Studies 
branch  requires manual settings.

Geometry

This tutorial uses a geometry that was previously created and stored in the 
COMSOL native CAD format,.mphbin. To learn how to build your own 
geometry, see “Appendix A—Building a Geometry” on page 136.

File Locations
The location of the application library that contains the file used in this exercise 
varies based on the software installation and operating system. In Windows®, the 
file path will be similar to: 
C:\Program Files\COMSOL\COMSOL52\Multiphysics\applications. 
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1 In the Model Builder window, under Component 1, right-click Geometry 1  
and select Import .

As an alternative, you can use the ribbon and click Import  from the 
Geometry tab.

2 In the Settings window for Import, from the Geometry import list, select 
COMSOL Multiphysics file.

3 Click Browse and locate the file wrench.mphbin in the application library 
folder of the COMSOL installation folder. Its default location in Windows® is
C:\Program 
Files\COMSOL\COMSOL52\Multiphysics\applications\COMSOL_Multiphysics\ 
Structural_Mechanics\wrench.mphbin

Double-click to add or click Open.
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4 Click Import to display the geometry in the Graphics window.

5 Click the wrench geometry in the Graphics window and then experiment with 
moving it around. As you point to or click the geometry, it changes color. Click 
the Zoom In , Zoom Out , Go to Default 3D View , Zoom Extents , 
and Transparency  buttons on the Graphics window toolbar to see what 
happens to the geometry:
- To rotate, click and drag anywhere in the Graphics window.
- To move, right-click and drag.
- To zoom in and out, click the mouse scroll wheel, continue holding it, and 

drag.
- To get back to the original position, click the Go to Default 3D View  

button on the toolbar.

Also see “Appendix B—Keyboard and Mouse Shortcuts” on page 151 for 
additional information.
The imported model has two parts, or domains, corresponding to the bolt and the 
wrench. In this exercise, the focus will be on analyzing the stress in the wrench.

Rotate: Click and drag

Pan: Right-click and drag
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Materials

The Materials node  stores the material properties for all physics and all domains 
in a Component node. Use the same generic steel material for both the bolt and 
tool. Here is how to choose it in COMSOL.
1 Open the Add Materials window.

You can open the Add Materials 
window in either of these two ways:
- Right-click Component 1>Materials 

 in the Model Builder and select 
Add Material

- From the ribbon, select the Home 
tab and then click Add Material.

2 In the Add Material window, click to 
expand the Built-In directory. Scroll 
down to find Structural steel, 
right-click, and select Add to 
Component 1.

3 Examine the Material Contents 
section in the Settings window for 
Material to see the properties that are 
available. Properties with green check 
marks are used by the physics in the 
simulation.

4 Close the Add Material window.

Also see the busbar tutorial sections “Materials” on page 61 and 
“Customizing Materials” on page 98 to learn more about working with 
materials.
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Global Definit ions

You will now define a global parameter specifying the load applied to the wrench.

Parameters
1 In the Model Builder, right-click Global Definitions  and choose 

Parameters .
2 Go to the Settings window for Parameters. Under Parameters in the Parameters 

table or in the fields below the table, enter these settings: 
- In the Name column or field, enter F.
- In the Expression column or field, enter 150[N]. The square-bracket 

notation is used to associate a physical unit to a numerical value, in this case 
the unit of force in Newtons. The Value column is automatically updated 
based on the expression entered once you leave the field or press Return.

- In the Description column or 
field, enter Applied force.

If you have a Parameters table with more than one entry, you can sort the 
table with respect to a particular column by clicking on the corresponding 
header.

The sections “Global Definitions” on page 57 and “Parameters, Functions, 
Variables and Couplings” on page 94 show you more about working with 
parameters.
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So far you have added the physics and 
study, imported a geometry, added the 
material, and defined one parameter. The 
Model Builder node sequence should 
now match the figure to the right. The 
default feature nodes under Solid 
Mechanics are indicated by a ‘D’ in the 
upper-left corner of the node icon .
The default nodes for Solid Mechanics 
are: a Linear Elastic Material model, Free 
boundary conditions that allow all 
boundaries to move freely without a 
constraint or load, and Initial Values for 
specifying initial displacement and 
velocity values for a nonlinear or transient 
analysis (not applicable in this case).
At any time, you can save your model and 
then open it later in exactly the state in 
which it was saved.
3 From the File Menu, select File > Save 

As. Browse to a folder where you have 
write permissions, and save the file as 
wrench.mph. 
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Domain Physics and Boundary Conditions

With the geometry and materials defined, you are now ready to set the boundary 
conditions.
1 In the Model Builder, right-click 

Solid Mechanics (solid)  and 
select Fixed Constraint .
This boundary condition 
constrains the displacement of each 
point on a boundary surface to be 
zero in all directions.

You can also use the ribbon and 
select, from the Physics tab, 
Boundaries > Fixed Constraint.

2 In the Graphics window, rotate 
the geometry by clicking 
anywhere in the window and then 
dragging the wrench into the 
position shown. Click on the 
exposed front surface of the 
partially modeled bolt. The 
boundary turns blue indicating 
that it has been selected. The 
Boundary number in the 
Selection list should be 35.

3 Click the Go to Default 3D View 
button  on the Graphics toolbar to restore the geometry to the default view. 
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4 In the Model Builder, right-click Solid Mechanics (solid)  and select 
Boundary Load. A Boundary Load node  is added to the Model Builder 
sequence.

5 In the Graphics window, click the 
Zoom Box button  on the 
toolbar and drag the mouse to 
select the square region shown in 
the figure to the right. Release 
the mouse button to zoom in on 
the selected region.

6 Select the top socket face 
(Boundary 111) by clicking the 
boundary to highlight it in blue 
and add it to the Selection list.
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7 In the Settings window for 
Boundary Load, under Force, 
select Total force as the Load type 
and enter -F in the text field for 
the z component. The negative 
sign indicates the negative 
z direction (downward). With 
these settings, the load of 150 N 
will be distributed uniformly across the selected surface.
Note that to simplify the modeling process, the mechanical contact between the 
bolt and the wrench is approximated with a material interface boundary 
condition. Such an internal boundary condition is automatically defined by 
COMSOL and guarantees continuity in normal stress and displacement across 
a material interface. A more detailed analysis including mechanical contact can 
be done with the Structural Mechanics Module.

Mesh

The mesh settings determine the resolution of the finite element mesh used to 
discretize the model. The finite element method divides the model into small 
elements of geometrically simple shapes, in this case tetrahedrons. In each 
tetrahedron, a set of polynomial functions is used to approximate the structural 
displacement field—how much the object deforms in each of the three coordinate 
directions.
In this example, because the geometry contains small edges and faces, you will 
define a slightly finer mesh than the default setting suggests. This will better 
resolve the variations of the stress field and give a more accurate result. Refining 
the mesh size to improve computational accuracy always involves some sacrifice in 
speed and typically requires increased memory usage.
1 In the Model Builder, under Component 1 click Mesh 1 . In the Settings 

window for Mesh, under Mesh Settings, select Fine from the Element size list.

2 Click the Build All button  in the Settings window or on the Mesh toolbar.
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3 After a few seconds the mesh is displayed in the Graphics window. Rotate the 
wrench to take a look at the element size distribution.

Study

In the beginning of setting up the model you selected a Stationary study, which 
implies that COMSOL will use a stationary solver. For this to be applicable, the 
assumption is that the load, deformation, and stress do not vary in time. The 
default solver settings will be good for this simulation if your computer has more 
than 2 GB of in-core memory (RAM). If you should run out of memory, the 
instructions below show solver settings that make the solver run a bit slower but 
use up less memory. To start the solver:
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1 Right-click Study 1  and select 
Compute  (or press F8).

If your computer’s memory is 
below 2 GB you may at this point get an error message “Out of Memory 
During LU Factorization”. LU factorization is one of the numerical 
methods used by COMSOL for solving the large sparse matrix equation 
system generated by the finite element method.

You can easily solve this example model on a memory-limited machine by allowing 
the solver to use the hard drive instead of performing all of the computation using 
RAM. The steps below show how to do this. If your computer has more than 
2 GB of RAM you can skip to the end of this section (after step 5 below).
1 If you did not already start the computation, you can access the solver settings 

from the Study node. In the Model Builder, right-click Study 1  and choose 
Show Default Solver .

2 Under Study 1>Solver Configurations, 
expand the Solution 1  node.

3 Expand the Stationary Solver 1  node and 
click Direct .
A Direct solver is a fast and very robust type 
of solver that requires little or no manual 
tuning in order to solve a wide range of 
physics problems. The drawback is that it may 
require large amounts of RAM.
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4 In the Settings window for Direct, 
in the General section, select the 
Out-of-core check box. Change 
the In-core memory method to 
Manual. Leave the default In-core 
memory (MB) setting of 512 MB.
This setting ensures that if your 
computer runs low on RAM 
during computation, the solver will 
start using the hard drive as a 
complement to RAM. Allowing 
the solver to use the hard drive 
instead of just RAM will slow the 
computation down somewhat.

5 Right-click Study 1  and select 
Compute  (or press F8).

After a few seconds of computation 
time, the default plot is displayed in 
the Graphics window. You can find 
other useful information about the computation in the Messages and Log 
windows; click the Messages and Log tabs under the Graphics window to see the 
kind of information available to you. The Messages window can also be opened 
from the Windows drop-down list in the Home tab of the ribbon.

Displaying Results

The von Mises stress is displayed in the Graphics window in a default Surface plot 
with the displacement visualized using a Deformation subnode. Change the 
default unit (N/m2) to the more suitable MPa as shown in the following steps. 
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1 In the Model Builder, expand the Results>Stress 
(solid)  node, then click Surface 1 .

2 In the Settings window under 
Expression, from the Unit list 
select MPa (or type MPa in the 
field).

To study the stress more accurately, 
expand the Quality section. From the 
Recover list select Within domains. This 
setting will recover information about 
the stress level from a collection of 
elements rather than from each element 
individually. It is not active by default since it makes visualizations 
slower. The Within domain setting treats each domain separately, and 
the stress recovery will not cross material interfaces.
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3 Click the Plot button  on the toolbar of the Settings window for the Surface 
plot and then click the Go to Default 3D View button  on the Graphics 
window toolbar.
The plot is regenerated with the updated unit and using the Within domain 
recovery setting. The von Mises stress distribution is shown in the bolt and 
wrench under an applied vertical load.

For a typical steel used for tools like a wrench, the yield stress is about 600 MPa, 
which means that we are getting close to plastic deformation for our 150 N load 
(which corresponds to about 34 pounds force). You may also be interested in a 
safety margin of, say, a factor of three. To quickly assess which parts of the wrench 
are at risk of plastic deformation, you can plot an inequality expression such as 
solid.mises>200[MPa].
1 Right-click the Results node  and add a 3D Plot Group .
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2 Right-click the 3D Plot Group 2 node  and select Surface .

3 In the Settings window for Surface, 
click the Replace Expression button  
and select Model>Component1>Solid 
Mechanics>Stress>solid.mises-von 
Mises stress by double-clicking. When 
you know the variable name 
beforehand, you can also directly enter 
solid.mises in the Expression field. 
Now edit this expression to: 
solid.mises>200[MPa].
This is a boolean expression that evaluates to either 1, for true, or 0, for false. 
In areas where the expression evaluates to 1, the safety margin is exceeded. 
Here, you also use the Recover feature described earlier.

4 Click the Plot button .
5 In the Model Builder, click 3D Plot Group 2. Press F2 and in the Rename 3D 

Plot Group dialog box, enter Safety Margin. Click OK.
The resulting plot shows that the stress in the bolt is high, but the focus of this 
exercise is on the wrench. If you wished to comfortably certify the wrench for a 
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150 N load with a factor-of-three safety margin, you would need to change the 
handle design somewhat, such as making it wider.

You may have noticed that the manufacturer, for various reasons, has chosen an 
asymmetric design for the wrench. Because of that, the stress field may be 
different if the wrench is flipped around. Try now, on your own, to apply the 
same force in the other direction and visualize the maximum von Mises stress to 
see if there is any difference.

Convergence Analysis

To check the accuracy of the computed maximum von Mises stress in the wrench, 
you can now continue with a mesh convergence analysis. Do that by using a finer 
mesh and therefore a higher number of degrees of freedom (DOFs).

This section illustrates some more in-depth functionality and the steps 
below could be skipped at a first reading. In order to run the convergence 
analysis below, a computer with at least 4GB of memory (RAM) is 
recommended.

EVALUATING THE MAXIMUM VON MISES STRESS

1 To study the maximum von Mises stress in the wrench, in the Results section of 
the model tree, right-click the Derived Values  node and select 
Maximum>Volume Maximum .
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2 In the Settings window for Volume Maximum, under Selection, choose Manual 
and select the wrench, domain 1, by clicking on the wrench in the Graphics 
window. We will only consider values in the wrench domain and neglect those 
in the bolt.

3 In the Expression text field enter the function ppr(solid.mises). The 
function ppr() corresponds to the Recover setting in the earlier note on page 
44 for Surface plots. The Recover setting with the ppr function is used to 
increase the quality of the stress field results. It uses a polynomial-preserving 
recovery (ppr) algorithm, which is a higher-order interpolation of the solution 
on a patch of mesh elements around each mesh vertex. It is not active by default 
since it makes Results evaluations slower.

4 Under Expression, select or enter MPa as the Unit.
5 In the Settings window for Volume 

Maximum, click Evaluate to 
evaluate the maximum stress. The 
result will be displayed in a Table 
window and will be approximately 
364 MPa.

6 To see where the maximum value is attained, you can use a Max/Min Volume 
plot. Right-click the Results node  and add a 3D Plot Group .

7 Right-click the 3D Plot Group 3 node  and select More Plots>Max/Min 
Volume .

8 In the Settings window for Max/Min Volume, in the Expression text field, 
enter the function ppr(solid.mises).

9 In the Settings window under Expression, from the Unit list select MPa (or 
enter MPa in the field).
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10Click the Plot button . This type of plot simultaneously shows the location of 
the max and min values and also their coordinate location in the table below.

PARAMETERIZING THE MESH

We will now define a parametric sweep for successively refining the mesh size while 
solving and then finally plot the maximum von Mises stress vs. mesh size. First, 
let’s define the parameters that will be used for controlling the mesh density.
1 In the Model Builder, click Parameters  under Global Definitions .
2 Go to the Settings window for Parameters. In the Parameters table (or under 

the table in the fields), enter these settings: 
- In the Name column or field, enter hd. This parameter will be used in the 

parametric sweep to control the element size.
- In the Expression column or field, enter 1.
- In the Description column or field, enter Element size divider.
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3 Now, enter another parameter with 
Name h0, Expression 0.01, and 
Description Starting element 
size. This parameter will be used to 
define the element size at the start of 
the parametric sweep.

4 In the Model Builder, under 
Component 1, click Mesh 1 . In the Settings window for Mesh select 
User-controlled mesh from the Sequence type list.

5 Under Mesh 1, click the Size node .
6 In the Settings window for Size, under 

Element Size, click the Custom button. 
Under Element Size Parameters, enter:
- h0/hd in the Maximum element size field.
- h0/(4*hd) in the Minimum element size 

field.
- 1.3 in the Maximum element growth rate 

field.
- 0.1 in the Curvature factor field.
- 0.2 in the Resolution of narrow regions 

field.
See page 71 for more information on the Element Size Parameters.

PARAMETRIC SWEEP AND SOLVER SETTINGS

As a next step, add a parametric sweep for the parameter hd.
1 In the Model Builder, right-click Study 1  and select 

Parametric Sweep . A Parametric Sweep node is 
added to the Model Builder sequence.

2 In the Settings window for Parametric Sweep, under 
the table in the Study Settings section, click the Add button . From the 
Parameter names list in the table, select hd.
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3 Enter a range of Parameter values to sweep 
for. Click the Range  button and enter 
the values in the Range dialog box. In the 
Start field, enter 1. In the Step field, enter 
1, and in the Stop field, enter 6. Click 
Replace. The Parameter value list will now 
display range(1,1,6).
The settings above make sure that as the 
sweep progresses, the value of the 
parameter hd increases and the maximum and minimum element sizes decrease. 
See page 123 for more information on defining parametric sweeps.
For the highest value of hd, the number of DOFs will exceed one million. 
Therefore, we will switch to a more memory-efficient iterative solver.

4 Under Study 1>Solver Configurations>Solution 1, expand the Stationary 
Solver 1 node, right-click Stationary Solver 1 , and select Iterative . The 
Iterative solver option typically reduces memory usage but can require 
physics-specific tailoring of the solver settings for efficient computations.

5 Under General in the Settings window for Iterative, set Preconditioning to 
Right. (This is a low-level solver option, which in this case will suppress a 
warning message that would otherwise appear. However, this setting does not 
affect the resulting solution. Preconditioning is a mathematical transformation 
used to prepare the finite element equation system for using the Iterative 
solver.)

6 Right-click the Iterative 1 node  and select Multigrid . The Multigrid 
iterative solver uses a hierarchy of meshes of different densities and different 
finite element shape function orders.

7 Click the Study 1 node and select Compute , either in the Settings window 
or by right-clicking the node. You can also click Compute in the ribbon Home 
or Study tab. The computation time will be a few minutes (depending on the 
computer hardware) and memory usage will be about 4GB.

RESULTS ANALYSIS

As a final step, analyze the results from the parametric sweep by displaying the 
maximum von Mises stress in a Table.
1 In the Model Builder under Results>Derived values, select the Volume 

Maximum 1 node .
The solutions from the parametric sweep are stored in a new Data Set named 
Study 1/Parametric Solutions 1. Now change the Volume Maximum settings 
accordingly:
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2 In the Settings window for Volume Maximum, change the Data set to Study 
1/Parametric Solutions 1.

3 Click the arrow next to the Evaluate button at the top of 
the Settings window for Volume Maximum and select to 
evaluate in a New Table. This evaluation may take a 
minute or so.

4 To plot the results in the Table, click the Table Graph  
button at the top of the Table window.
It is more interesting to plot the maximum value vs. the 
number of DOFs. This is possible by using a built-in variable numberofdofs.

5 Right-click the Derived Values node  and select Global Evaluation .
6 In the Settings window for Global Evaluation, change the Data set to Study 

1/Parametric Solutions 1.
7 In the Expressions field, enter numberofdofs.
8 Click the arrow next to the Evaluate button in the Settings window for Global 

Evaluation and select to evaluate in Table 2. This displays the DOF values for 
each parameter next to the previously evaluated data.

This convergence analysis shows that the computed value of the maximum von 
Mises stress in the wrench handle will increase from the original 355 MPa, for a 
mesh with about 60,000 DOFs, to 370 MPa for a mesh with about 1,100,000 
DOFs. It also shows that 300,000 DOFs essentially gives the same accuracy as 
1,100,000 DOFs; see the table below.

This concludes the wrench tutorial.

DEGREES OF FREEDOM COMPUTED MAX VON 
MISES STRESS (MPA)

58,899 354.8

177,918 364.3

314,181 368.5

585,849 369.0

862,509 369.6

1,126,380 369.8
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Example 2: The Busbar—A Multiphysics Model

Electrical Heating in a Busbar
This tutorial demonstrates the concept of multiphysics modeling in COMSOL. 
We will do this by defining the different physics settings sequentially. At the end, 
you will have built a truly multiphysics model.
The model that you are about to create analyzes a busbar designed to conduct 
direct current to an electrical device (see picture below). The current conducted 
in the busbar, from bolt 1 to bolts 2a and 2b, produces heat due to the resistive 
losses, a phenomenon referred to as Joule heating. The busbar is made of copper 
while the bolts are made of a titanium alloy. Under normal operational conditions 
the currents are predominantly conducted through the copper. This example, 
however, illustrates the effects of an unwanted electrical loading of the busbar 
through the bolts. The choice of materials is important because titanium has a 
lower electrical conductivity than copper and will be subjected to a higher current 
density. 

The goal of your simulation is to precisely calculate how much the busbar heats 
up. Once you have captured the basic multiphysics phenomena, you will have the 
chance to investigate thermal expansion yielding structural stresses and strains in 
the busbar and the effects of cooling by an air stream.
The Joule heating effect is described by conservation laws for electric current and 
energy. Once solved for, the two conservation laws give the temperature and 
electric field, respectively. All surfaces, except the bolt contact surfaces, are cooled 
by natural convection in the air surrounding the busbar. You can assume that the 
exposed parts of the bolt do not contribute to the cooling or heating of the device. 

Titanium Bolt 2b Titanium Bolt 1

Titanium Bolt 2a
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The electric potential at the upper-right vertical bolt surface is 20 mV and the 
potential at the two horizontal surfaces of the lower bolts is 0 V. This corresponds 
to a relatively high and potentially unsafe loading of this type of busbar. More 
advanced boundary conditions for electromagnetics analysis are available with the 
AC/DC Module, such as the capability to give the total current on a boundary.

Busbar Model Overview
More in-depth and advanced topics included in this tutorial are used to show you 
some of the many options available in COMSOL. The following topics are 
covered:
• “Parameters, Functions, Variables and Couplings” on page 94, where you 

learn how to define functions and component couplings.
• “Material Properties and Material Libraries” on page 98 shows you how to 

customize a material and add it to your own material library.
• “Adding Meshes” on page 100 gives you the opportunity to add and define 

two different meshes and compare them in the Graphics window.
• “Adding Physics” on page 102 explores the multiphysics capabilities by 

adding Solid Mechanics and Laminar Flow to the busbar model.
• “Parametric Sweeps” on page 123 shows you how to vary the width of the 

busbar using a parameter and then solve for a range of parameter values. The 
result is a plot of the average temperature as a function of the width.

• In the section “Parallel Computing” on page 132 you learn how to solve the 
model using Cluster Computing.

Model Wizard

1 To open the software, double-click the COMSOL icon on 
the desktop. 

When the software opens, click the Model Wizard button. 
You can also start the Model Wizard at any time by 
selecting New from the File menu. Then, choose Model 
Wizard.
54 | 



2 In the Select Space Dimension window, click 3D.

3 In the Select Physics window, expand 
the Heat Transfer > Electromagnetic 
Heating folder, then right-click Joule 
Heating  and choose Add Physics. 
Click the Study  button. 
You can also double-click or click the 
Add button to add physics.
Another way to add physics is to open 
the Add Physics window by 
right-clicking the Component node in 
the Model Builder and selecting Add 
Physics .
Note, you may have fewer items in your 
physics list depending on the add-on 
modules installed. The figure on the 
right is shown for the case where all 
add-on modules are installed.
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4 In the Select Study window, click to 
select the Stationary  study type. 
Click the Done button. 
Preset Studies are studies that have 
solver and equation settings adapted to 
the selected physics; in this example, 
Joule Heating.
Any selection from the Custom Studies 
branch  needs manual fine-tuning.
Note, you may have fewer study types in 
your study list depending on the 
installed add-on modules.

The Joule Heating multiphysics 
interface consists of two physics 
interfaces, Electric Currents and 
Heat Transfer in Solids, together 
with the multiphysics couplings 
that appear in the Multiphysics 
branch: the electromagnetic heat 
sources and a temperature 
coupling. This multiphysics 
approach is very flexible and makes 
it possible to fully use the 
capabilities of the participating 
physics interfaces.
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Global Definit ions

To save time, it’s recommended that you 
load the geometry from a file. In that case, 
you can skip to “Geometry” on page 58.
If, on the other hand, you want to draw the 
geometry yourself, the Global Definitions 
node is where you define the parameters. 
First, complete steps 1 through 3 below to 
define the parameter list for the model. 
Then follow step 4 and skip to the section 
“Appendix A—Building a Geometry” on 
page 136.
The Global Definitions node  in the 
Model Builder stores Parameters, Variables, 
and Functions with a global scope. The 
model tree can hold several model 
components simultaneously, and the 
definitions with a global scope are made 
available for all components. In this 
particular example, there is only one Component node in which the parameters 
are used, so if you wish to limit the scope to this single component you could 
define, for example, Variables and Functions in the Definitions subnode available 
directly under the corresponding Component node. However, no Parameters can 
be defined here because Parameters are always global.
Since you will run a parametric study of the geometry later in this example, define 
the geometry using parameters from the start. In this step, enter parameters for 
the length of the lower part of the busbar, L, the radius of the titanium bolts, 
rad_1, the thickness of the busbar, tbb, and the width of the device, wbb.
You will also add the parameters that control the mesh, mh, a heat transfer 
coefficient for cooling by natural convection, htc, and a value for the voltage 
across the busbar, Vtot.
1 Right-click Global Definitions  and choose Parameters . In the Parameters 

table, click the first row under Name and enter L. 
2 Click the first row under Expression and enter the value of L, 9[cm]. You can 

enter the unit inside the square brackets.
3 Continue adding the other parameters: rad_1, tbb, wbb, mh, htc, and Vtot 

according to the Parameters list below. It is a good idea to enter descriptions for 

2 x rad_1

wbb
L

tbb
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variables in case you want to share the model with others and for your own 
future reference.

4 Click the Save button  on the Quick Access Toolbar and name the model 
busbar.mph. Then go to “Appendix A—Building a Geometry” on page 136.

Geometry

This section describes how the geometry can be opened from the Application 
Libraries. The physics, study, parameters, and geometry are included with the 
model file you are about to open.
1 Select Application Libraries  from the 

Windows drop down in the Home tab.
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2 In the Application Libraries tree under 
COMSOL Multiphysics > Multiphysics, 
select busbar geom. 
To open the file you can:
- Double-click the name
- Right-click and select an option from 

the menu
- Click one of the buttons under the 

tree

You can select No if prompted to save 
untitled.mph.
The geometry in this file is 
parameterized. In the next few steps, we 
will experiment with different values for 
the width parameter, wbb.

3 Under Global Definitions  click the 
Parameters node . 
In the Settings window for Parameters, 
click in the Expression column for the 
wbb parameter and enter 10[cm] to 
change the value of the busbar width.

4 In the Model Builder, under 
Component 1>Geometry 1, click the 
Form Union node  and then the Build 
All button in the Settings window  to rerun the geometry sequence. You can 
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also use the ribbon and click Build All from the Geometry group in the Home 
tab.

5 In the Graphics toolbar click the Zoom Extents button  to see the wider 
busbar in the Graphics window. 

wbb=10cmwbb=5cm
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6 Experiment with the geometry in the Graphics window:
- To rotate the busbar, click and drag the pointer anywhere in the Graphics 

window.
- To move it, right-click and drag.
- To zoom in and out, click the scroll wheel, continue holding it, and drag.

- To get back to the original position, click the Go to Default 3D View 
button  on the toolbar.

7 Return to the Parameters table and 
change the value of wbb back to 5[cm].

8 In the Model Builder, click the Form 
Union node  and then click the Build 
All button  to rerun the geometry 
sequence.

9 On the Graphics toolbar, click the 
Zoom Extents button .

10If you built the geometry yourself, you 
are already using the busbar.mph file, but if you opened the file from the 
Application Libraries, select Save As from the File menu and rename the model 
busbar.mph. 

After creating or importing the geometry, it is time to define the materials.

Materials

The Materials node  stores the material properties for all physics and geometrical 
domains in a Component node. The busbar is made of copper and the bolts are 
made of a titanium alloy. Both of these materials are available from the Built-In 
material database.
1 In the Model Builder, right-click Component 1>Materials  and select Add 

Material . By default, the window will open at the right-hand side of the 
desktop. You can move the window by clicking on the window title and then 
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dragging it to a new location. While dragging the window, you will be presented 
with several options for docking.

The Materials node will show a red × in the lower-left corner if you try to 
solve without first defining a material (you are about to define that in the 
next few steps).

2 In the Add Material window, 
expand the Built-In materials 
folder and locate Copper. 
Right-click Copper  and 
select Add to Component 1. 
A Copper node is added to the 
Model Builder.

3 In the Add Material window, 
scroll to Titanium beta-21S in 
the Built-In material folder list. 
Right-click and select Add to 
Component 1. 

4 In the Model Builder, collapse 
the Geometry 1 node  to get 
an overview of the model.
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5 Under the Materials node, click Copper .

6 In the Settings window for Material, examine the Material Contents section.

The Material Contents section has useful information about the material 
property usage of a model. Properties that are both required by the physics and 
available from the material are marked with a green check mark . Properties 
required by the physics but missing in the material are marked with a warning 
sign . A property that is available but not used in the model is unmarked.

The Coefficient of thermal expansion in the table above is not used, but 
will be needed later when heat-induced stresses and strains are added to 
the model.

Because the copper material is added first, by default all parts have copper 
material assigned. In the next step you will assign titanium properties to the 
bolts, which overrides the copper material assignment for those parts.

7 In the Model Builder, click Titanium beta-21S .
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8 Select All Domains from the Selection list and then click domain 1 in the list. 
Now remove domain 1 from the selection list. 
To remove a domain from the selection list (or any geometric entity such as 
boundaries, edges, or points), you can use either of these two methods:
- Click domain 1 in the selection list found in the Settings window for Material, 

then click the Remove from Selection button  or press Delete on your 
keyboard.

- Alternatively, in the Graphics window, click domain 1 to remove it from the 
selection list.

The domains 2, 3, 4, 5, 6, and 7 are highlighted in blue.
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To render the copper components in the actual color of the material, open 
the Preferences window from the File menu. Then on the Graphics and 
Plot Windows page, select the Show material color and texture check box. 
This will also enable material-true rendering of the other materials.

9 In the Settings window for 
Material, be sure to inspect 
the Material Contents section 
for the titanium material. All 
the properties used by the 
physics should have a green 
check mark .

10Close the Add Material 
window either by clicking the 
icon in the upper right corner or 
by clicking the Add Material 
toggle button  in the 
Materials group of the ribbon 
Home tab.
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Physics

Next you will inspect the physics domain settings and set the boundary conditions 
for the heat transfer problem and the conduction of electric current.
In the Model Builder window, examine the default physics nodes of the 
multiphysics interface for Joule Heating. First, collapse the Materials node. Then 
click the arrows next to the Electric Currents , Heat Transfer in Solids , and 
Multiphysics  nodes to expand them.

The ‘D’ in the upper left corner of a node’s icon ( ) means it is a default node.
The equations that COMSOL solves are displayed in the Equation section of the 
Settings windows of the respective physics nodes.
The default equation form is inherited from the study added in the Model Wizard. 
For Joule heating, COMSOL displays the equations solved for the temperature 
and electric potential.

To always display the equations in the Settings window, click the Show 
button ( ) on the Model Builder toolbar and select Equation Sections so 
that a check mark appears next to it. 
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The Heat Transfer in Solids (ht) and 
Electric Currents (ec) nodes have the 
settings for heat conduction and 
current conduction, respectively. 
Under the Electric Currents node, 
the Current Conservation node 
represents the conservation of electric 
current at the domain level and the 
Electric Insulation node contains the 
default boundary condition for 
Electric Currents.
Under the Heat Transfer in Solids 
node, the domain level Heat Transfer 
in Solids node represents the 
conservation of heat and the Thermal 
Insulation node contains the default 
boundary condition for Heat Transfer. The heat source for Joule heating is set in 
the Electromagnetic Heat Source node under the Multiphysics node. The Initial 
Values node, found in both the Electric Currents and Heat Transfer in Solids 
interfaces, contains initial guesses for the nonlinear solver for stationary problems 
and initial conditions for time-dependent problems.
Now, define the boundary conditions.
1 Right-click the Heat Transfer in Solids node . In the second section of the 

context menu—the boundary  section—select Heat Flux. 

Boundary section

Section divider

Domain section
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2 In the Settings window for Heat 
Flux, select All boundaries from the 
Selection list.
Assume that the circular bolt 
boundaries are neither heated nor 
cooled by the surroundings.
In the next step you will remove the 
selection of these boundaries from 
the heat flux selection list, which 
leaves them with the default insulating boundary condition for the Heat 
Transfer interfaces.

3 Rotate the busbar to view the back. Move the mouse pointer over one of the 
circular titanium bolt surfaces to highlight it in green. Click the bolt surface to 
remove this boundary selection from the Selection list. Repeat this step to 
remove the other two circular bolt surfaces from the selection list. Boundaries 
8, 15, and 43 are removed.

Cross-check: Boundaries 8, 15, and 43 are removed from the 
Selection list.

43

15

8
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4 In the Settings window for Heat 
Flux under Heat Flux, click the 
Convective heat flux button. Enter 
htc in the Heat transfer coefficient 
field, h.
This parameter was either entered 
in the Parameter table in “Global 
Definitions” on page 57 or 
imported with the geometry.
Continue by setting the boundary 
conditions for the electric current 
according to the following steps:

5 In the Model Builder, right-click the Electric Currents node . In the second 
section of the context menu—the boundary section—select Electric Potential. 
An Electric Potential  node is added to the model tree. 
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6 Move the mouse pointer over the circular face of the single titanium bolt to 
highlight it and then click to add it (boundary 43) to the Selection list.

7 In the Settings window for Electric 
Potential enter Vtot in the Electric 
potential field.
The last step is to set the surfaces of 
the two remaining bolts to ground.

8 In the Model Builder, right-click the Electric Currents node . In the 
boundary section of the context menu, select Ground. A Ground node  is 
added to the Model Builder. The model tree node sequence should now match 
this figure.

43
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9 In the Graphics window, click one of the remaining bolts to add it to the 
Selection list.

Repeat this step to add the last bolt. Boundaries 8 and 15 are added to the 
selection list for the Ground boundary condition.

10On the Graphics toolbar, click the Go to Default 3D View button .

As an alternative to using the preconfigured multiphysics interface for 
Joule heating, you can manually combine the Electric Currents and Heat 
Transfer in Solids interfaces. For example, you can start by setting up and 
solving the model for Electric Currents and then subsequently add Heat 
Transfer in Solids. In that case, you right-click the Multiphysics node to 
add the required multiphysics couplings.

Mesh

The simplest way to mesh is to create an unstructured tetrahedral mesh, which is 
perfect for the busbar. Alternatively, you can create several meshing sequences as 
shown in “Adding Meshes” on page 100.

A physics-controlled mesh is created by default. In most cases, it is possible 
to skip to the Study branch and just solve the model. For this exercise, the 
settings are investigated in order to parameterize the mesh settings.

Cross-check: Boundaries 8 and 15.

15

8
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1 In the Model Builder, click the Mesh 1 
node . In the Settings window for 
Mesh, select User-controlled mesh from 
the Sequence type list. 

2 Under Mesh 1, click the Size node .

3 In the Settings window for Size 
under Element Size, click the 
Custom button. 
Under Element Size Parameters, 
enter:
- mh in the Maximum element size 

field. Note that mh is 6 mm—the 
value entered earlier as a global 
parameter. By using the 
parameter mh, element sizes are 
limited to this value.

- mh-mh/3 in the Minimum 
element size field. The 
Minimum element size is slightly 
smaller than the maximum size. 

- 0.2 in the Curvature factor field. 
The Curvature factor 
determines the number of 
elements on curved boundaries; 
a lower value gives a finer mesh.

The other two parameters are left 
unchanged.
The Maximum element growth rate determines how fast the elements should 
grow from small to large over a domain. The larger this value is, the larger the 
growth rate. A value of 1 does not give any growth.
For Resolution of narrow regions, a higher value will in general result in a finer 
mesh.
The asterisk (*) that displays in the upper-right corner of the Size node  
indicates that the node is being edited.
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4 Click the Build All button  in the Settings window for Size to create the mesh 
as in this figure: 

You can also click Build Mesh in the Home tab of the ribbon.

Study

1 To run a simulation, in the Model 
Builder, right-click Study 1  and 
choose Compute . You can also 
press F8 or click Compute in the 
ribbon Home tab.

The Study node  automatically 
defines a solution sequence for the 
simulation based on the selected 
physics and the study type. The 
simulation only takes a few seconds to 
solve. During the solution process, two Convergence plots are generated and are 
available from tabs next to the Graphics window. These plots show the 
convergence progress of the different solver algorithms engaged by the Study.
 | 73



Results

By default, in the Results node, three plot groups are 
generated: a Multislice plot of the Electric Potential, a 
Surface plot of the Temperature, and a plot named 
Isothermal Contours containing an Isosurface plot of 
the temperature.
Click Results > Temperature  to view the temperature 
plot in the Graphics window. The temperature 
difference in the device is less than 10 K due to the high 
thermal conductivity of copper and titanium. The 
temperature variations are largest in the top bolt, which 
conducts double the amount of current compared to the two lower bolts. The 
temperature is substantially higher than the ambient temperature of 293 K.
1 Click and drag the image in the Graphics window to rotate and view the back 

of the busbar.

2 On the Graphics toolbar, click the Go to Default 3D View button .
You can now manually set the color table range to visualize the temperature 
difference in the copper part.

3 In the Model Builder, expand the Results > Temperature node  and click the 
Surface 1 node .
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4 In the Settings window for Surface click Range to expand the section. Select the 
Manual color range check box and enter 323 in the Maximum field (replace the 
default). Click the Plot button  on the Settings window for Surface. 

5 On the Graphics toolbar, click the Zoom Extents button  to view the updated 
plot.
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6 Click and drag in the Graphics window to rotate the busbar and view the back. 

The temperature distribution is laterally symmetric with a vertical mirror plane 
running between the two lower titanium bolts and cutting through the center of 
the upper bolt. In this case, the model does not require much computing power 
and you can model the entire geometry. For more complex models, you can 
consider using symmetries to reduce the computational requirements. 
Select Go to Default 3D View on the toolbar in the Graphics window .
Now, let us generate a Surface plot that shows the current density in the device.
1 In the Model Builder, right-click 

Results  and add a 3D Plot 
Group . Right-click 3D Plot 
Group 4  and add a Surface 
node .
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2 In the Settings window for Surface under 
Expression, click the Replace Expression 
button . Go to 
Model>Component1>Electric Currents > 
Currents and charge > ec.normJ -Current 
density norm and double-click or press Enter 
to select.

ec.normJ is the variable for the magnitude, 
or absolute value, of the current density 
vector. You can also enter ec.normJ in the 
Expression field when you know the variable 
name.

3 Click the Plot button . 
The plot that displays in the Graphics window is almost uniform in color due to 
the high current density at the contact edges with the bolts. The next step is to 
manually change the color table range to visualize the current density 
distribution.

4 In the Settings window for Surface under Range, select the Manual color range 
check box. Enter 1e6 in the Maximum field and replace the default.
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5 Click the Plot button . 
The resulting plot shows that the current takes the shortest path in the 
90-degree bend in the busbar. Notice that the edges of the busbar outside of 
the bolts are hardly utilized for current conduction.

6 Click and drag the busbar in the Graphics window to view the back. Continue 
rotating the image to see the high current density around the contact surfaces 
of each of the bolts. 

When you are done, click the Go to Default 3D View button  on the Graphics 
toolbar.
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GETTING THE MAXIMUM AND MINIMUM TEMPERATURE

You can easily obtain the maximum and minimum temperature values in the 
busbar, including their locations.
1 Right-click Results > Temperature  and select More Plots > Max/Min 

Volume. 

2 In the Settings window for Max/Min Volume under Expression, click the 
Replace Expression button . Go to Model > Component 1 > Heat Transfer 
in Solids > Temperature > T - Temperature and double-click or press Enter to 
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select. You can also search for Temperature in the search field above the tree of 
postprocessing variables. Click Plot.

The maximum and minimum values are plotted in the Graphics window and 
their locations and values are displayed in the Maximum and minimum values 
table.
80 | 



As an alternative to the method described above of plotting the maximum and 
minimum values, you can use the Derived Values node for a pure numerical 
output.
3 In the Results section of the model tree, right-click the Derived Values  node 

and select Maximum>Volume Maximum .
4 In the Settings window for Volume Maximum, under Selection, choose All 

domains.
5 In the Expression text field enter T for the temperature and click Evaluate at the 

top of the Settings window.

The resulting maximum temperature is shown in Table 1.

As a next step you will create a model thumbnail image.

CREATING MODEL IMAGES FROM PLOTS

With any solution, you can create an image to display in COMSOL when 
browsing for model files. After generating a Plot, in the Model Builder under 
Results, click the plot. Then click the root node (the first node in the model tree). 
In the Settings window for Root under Thumbnail, click Set from Graphics 
Window. 
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There are two other ways to create images from a plot. One is to click the 
Image Snapshot button  in the Graphics toolbar to directly create an image. You 
can also add an Image node  to an Export node to create an image file. 
Right-click the plot group of interest and then select Add Image to Export. 

Make sure to save the model at this stage. This version of the model, 
busbar.mph, is reused and renamed during the next set of tutorials.

Creating an Application using the New Form Wizard

This section gives a brief introduction to creating an application based on the 
busbar model. The application will have a specialized user interface dedicated to 
interact with the busbar model and include input fields for the length, width, and 
applied voltage. The outputs will be the maximum temperature and a temperature 
plot.
You will learn how to use the New Form wizard to quickly create an application. 
The New Form wizard is used to create a form with user interface components 
called form objects. The wizard gives quick access to a subset of all the form 
objects available for creating applications with the Application Builder. In this 
example you will learn how to use the wizard to add input fields, numerical 
output, graphics, and buttons. For detailed information on building applications, 
see the book Introduction to Application Builder.
1 To switch from the Model Builder to the Application Builder, click the 

Application Builder button in the leftmost part of the Home tab in the ribbon.
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2 To create a new form, click the New Form button in the ribbon.

The wizard window now appears.

It consists of three tabs for Inputs/outputs, Graphics, and Buttons. In the 
Inputs/outputs tab you can double-click the nodes in the tree to make these 
available in the user interface of the application. For this application we will 
select a few of the parameters as input fields and the maximum temperature as 
output.
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3 Double-click each of the Parameters: Length (L), Width (wbb), and Applied 
voltage (Vtot). Also, double-click the Volume Maximum under Derived Values.

The Preview section to the right displays the user interface layout.
4 Click the Graphics tab in the wizard and double-click the Temperature plot. A 

graphics object placeholder appears in the Preview area.
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5 Click the Buttons tab in the wizard and double-click Compute Study 1. A 
button now appears in the Preview area beneath the graphics object.

6 Finally, click OK to accept the settings and close the wizard.

After closing the New Form wizard, the Form editor is opened. The Form editor 
allows you to drag-and-drop form objects and add new ones
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7 You can, for example, rearrange the user interface by placing the graphics object 
to the right of the input fields and the button directly under the input fields, as 
shown in the figure below. Blue guide lines will aid you in aligning the objects.

You can make the graphics object larger by dragging the blue handles.
8 You can test the application by clicking Test Application in the ribbon.

This creates a run-time copy of the application and lets you quickly try different 
designs during the process of developing an application.
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9 Now, try a different Length value and click Compute.

You may wish to preview the geometry before starting the computation and this 
can easily be done by adding a button. There are two ways of adding a button. 
Either use the Insert Object menu in the ribbon, as shown in the figure below
or use the Editor Tools window. In this example, you will use the latter.

1 First, make sure the Editor Tools window is visible by selecting the 
corresponding button in the ribbon.
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2 In the Editor Tools tree, right-click the Geometry node and select Button.

3 Drag the Plot Geometry button to the left of the Compute button.

Behind each button is a command sequence that controls the action taken when 
it is pressed. The command sequence is defined in the Settings window of the 
button and you can open the Settings window (if not already opened) by 
double-clicking the button. 
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4 Double-click the Plot Geometry button to see its Settings window. Command 
sequences appear below the tree in the section Choose Commands to Run.

In this case, the command sequence for the Plot Geometry has one command 
for plotting the geometry. The input argument contains information on which 
graphics window to send the geometry plot. In this case the graphics object 
graphics1.
To automatically adjust the axis settings, you can add a Zoom Extents 
command.

5 In the Choose Commands to Run section, locate the Zoom Extents command 
under GUI Commands > View Commands. Double click to add it to the 
command sequence.
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6 Now create the input argument to the Zoom Extents command. Click the white 
field next to Zoom extents and click the Edit Argument button.

7 This opens a dialog box with possible input arguments. Select graphics1 under 
form1.
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8 The command sequence is now complete.

9 To make sure the new Plot Geometry button works, you can now test the 
application again by clicking Test Application in the ribbon.

To perform more advanced operations than what is possible to do with a 
command sequence, you can use the Method editor to write code that defines the 
actions to be taken when the user clicks a button. An easy way to get started with 
the Method editor is to convert an existing command sequence into a method. 
1 Locate or open the Settings window for the Plot Geometry button again. Click 

the Convert to New Method button below the command sequence.
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2 To open the method in the Method editor, click the Go to Method button 
below the command sequence. 

The Method editor now opens with the code for method1 corresponding to the 
Plot Geometry and the Zoom Extents commands in the previous command 
sequence.

The Application Builder has several tools for automatically generating code. In 
addition to converting a command sequence to a method, you can, for example, 
click Record Code in the ribbon.

This will automatically switch over to the Model Builder and generate code for 
each operation performed there. Click Stop Recording in the ribbon to stop 
recording and go back to the Method Editor.
To learn more about using the Form Editor and the Method Editor, see the book 
Introduction to Application Builder.
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This completes the Busbar example. To switch back to the Model Builder click the 
Model Builder button in the ribbon.

The next sections are designed to deepen your understanding of the steps 
implemented so far, and to extend your simulation to include additional effects 
like thermal expansion and fluid flow. These additional topics begin on the 
following pages:
• “Parameters, Functions, Variables and Couplings” on page 94
• “Material Properties and Material Libraries” on page 98 
• “Adding Meshes” on page 100 
• “Adding Physics” on page 102
• “Parametric Sweeps” on page 123
• “Parallel Computing” on page 132
• “Appendix A—Building a Geometry” on page 136
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Advanced Topics

Parameters,  Functions,  Variables and Couplings

This section explores working with Parameters, Functions, Variables, and 
Component Couplings.
Global Definitions and Component Definitions contain functionality that help 
you to prepare model inputs and component couplings, and to organize 
simulations. You have already used the functionality for adding Parameters to 
organize model inputs in “Global Definitions” on page 57.
Functions, available as both Global Definitions and Component Definitions, 
contain a set of predefined function templates that can be useful when setting up 
multiphysics simulations. For example, the Step function template can create a 
smooth step function for defining different types of spatial or temporal transitions. 
To illustrate using functions, assume that you want to add a time dependent study 
to the busbar model where an electric potential is applied across the busbar that 
goes from 0 V to 20 mV in 0.5 seconds. For this purpose, you could use a step 
function to be multiplied with the parameter Vtot. In this section, you’ll add a 
step function to the model that goes smoothly from 0 to 1 in 0.5 seconds to find 
out how functions can be defined and verified.

DEFINING FUNCTIONS

For this section, you can continue working with the same model file created in the 
previous section. Locate and open the file busbar.mph if it is not already open on 
the desktop.
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1 Right-click the Global Definitions node  and select Functions>Step .

2 In the Settings window for Step enter 0.25 in the Location field to set the 
location of the middle of the step, where it has the value of 0.5.

3 Click Smoothing to expand the section and enter 0.5 in the Size of transition 
zone field to set the width of the smoothing interval. Keep the default Number 
of continuous derivatives at 2.

4 Click the Plot button  in the Settings window for Step.
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If your plot matches the one below, this confirms that you have defined the 
function correctly.

You can also add comments and rename the function to make it more descriptive.
5 Right-click the Step 1 node  

in the Model Builder and 
select Properties .
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6 In the Properties window, enter any 
information you want. Right-click 
the Properties tab and select Close 
when you are finished.

For the purpose of this exercise, 
assume that you want to introduce a 
second component to represent an 
electric device connected to the 
busbar through the titanium bolts.
A first step would be to rename 
Component 1 to specify that it 
represents the busbar.
1 Right-click the Component 1 node  and select Rename  (or press F2).
2 In the Rename Component window, enter Busbar. Click OK and save the 

model.

DEFINING COMPONENT COUPLINGS

Right-click the Definitions node  under 
Busbar (comp1) to introduce a Component 
Coupling that computes the integral of any 
Busbar (comp1) variable at the bolt boundaries 
facing the electric device. You can use such a 
coupling, for example, to define a Variable in 
the Global Definitions node that calculates the 
total current. This variable is then globally 
accessible and could, for example, form a 
boundary condition for the current that is fed 
to an electric device modeled as a second 
component.
The Component Couplings in Definitions have 
a wide range of uses. The Average , 
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Maximum , and Minimum  couplings have applications in generating results 
as well as in boundary conditions, sources, sinks, properties, or any other 
contribution to the model equations. The Probes  are for monitoring the 
solution progress. For instance, you can follow the solution at a critical point 
during a time-dependent simulation, or for each parameter value in a parametric 
study. 
You can find an example of using the average operator in “Parametric Sweeps” on 
page 123. Also see “Functions” on page 160 for a list of available COMSOL 
functions.

To learn more about working with definitions, in the Model Builder, click 
the Definitions  or Global Definitions  node and press F1 to open the 
Help window . This window displays helpful information about the 
selected item in the desktop and provides links to the documentation. It 
could take up to a minute for the window to load the first time it is activated, 
but will load quickly the next time it is opened.

Material  Properties and Material  Libraries

You have already used the functionality in Materials to access the properties of 
copper and titanium in the busbar model. In Materials, you are also able to define 
your own materials and save them in your material library. You can also add 
material properties to existing materials. In cases where you define properties that 
are functions of other variables, typically temperature, the plot functionality helps 
you to verify the property functions in the range of interest. You can also load 
Excel® spreadsheets and define interpolation functions for material properties 
using LiveLink™ for Excel®.
The Material Library add-on contains over 2500 materials with tens of thousands 
of temperature-dependent property functions.
First investigate how to add properties to an existing material. Assume that you 
want to add bulk modulus and shear modulus to the copper properties.

CUSTOMIZING MATERIALS

Let us keep working on the busbar.
1 In the Model Builder, under Materials, click 

Copper .
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2 In the Settings window for 
Material, click to expand the 
Material Properties section, which 
contains a list of all the definable 
properties.
Expand the Solid Mechanics > 
Linear Elastic Material section. 
Right-click Bulk Modulus and 
Shear Modulus and select  Add 
to Material.
This lets you define the bulk 
modulus and shear modulus for the copper in your model.

3 Locate the Material Contents section. Bulk modulus and Shear modulus rows 
are now available in the table. The warning sign  indicates that the values are 
not yet defined. To define the values, click the Value column. In the Bulk 
modulus row, enter 140e9 and in the Shear modulus row, enter 46e9.

By adding these material properties, you have changed the Copper material. You 
can save this information in your own material library, but not in the read-only 
Solid Mechanics materials library.
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4 In the Model Builder, right-click Copper and select “Add to User-Defined 
Library” .

Adding Meshes

A model component can contain different meshing sequences for generating 
meshes with different settings. These sequences can then be accessed by the study 
steps. In the study, you can select which mesh you would like to use in a particular 
simulation.
In the busbar model, a second mesh node is now added to create a mesh that is 
refined in the areas around the bolts and the bend.

ADDING A MESH

1 Open the model busbar.mph 
that was created earlier.

2 In order to keep this model in a 
separate file for later use, select 
File > Save As and rename the 
model busbar_I.mph.

3 To add a second mesh node, 
right-click the Component 
1(comp1) node  and select Add 
Mesh .
By adding another Mesh node, a 
Meshes parent node is created 
that contains both Mesh 1 and 
Mesh 2.
100 | 



4 Click the Mesh 2 node. In the 
Settings window for Mesh under 
Mesh Settings, select 
User-controlled mesh as the 
Sequence type.
A Size and Free Tetrahedral node 
are added under Mesh 2. 

5 In the Model Builder, under 
Mesh 2, click Size .

The asterisk in the upper-right corner of a node icon indicates that the node is 
being edited.

6 In the Settings window for Size, under Element Size, click the Custom button. 
7 Under Element Size Parameters, enter:

- mh/2 in the Maximum element size field, where mh is 6 mm—the mesh 
control parameter defined previously.

- mh/2-mh/6 in the Minimum element size field.
- 0.2 in the Curvature factor field.

8 Click Build All . Save the file busbar_I.mph.
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Compare Mesh 1 and Mesh 2 by clicking the Mesh nodes. The mesh is updated 
in the Graphics window. An alternative to using many different meshes is to run a 
parametric sweep of the parameter for the maximum mesh size, mh, that was 
defined in the section “Global Definitions” on page 57.

Adding Physics

The distinguishing characteristics of COMSOL, particularly adaptability and 
compatibility, are prominently displayed when you add physics to an existing 
model. In this section, you will understand the ease with which this seemingly 
difficult task is performed. By following these directions, you can add structural 
mechanics and fluid flow to the busbar model.

STRUCTURAL MECHANICS

After completing the busbar Joule heating simulation, we know that there is a 
temperature rise in the busbar. What kind of mechanical stress is induced by 
thermal expansion? To answer this question, let us expand the model to include 
the physics associated with structural mechanics. 

Mesh 1 Mesh 2
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To complete these steps, either the Structural Mechanics Module or the 
MEMS Module (which enhances the core Solid Mechanics interface) is 
required.
If you want to add cooling by fluid flow, or don’t have the Structural 
Mechanics Module or MEMS Module, read this section and then go to 
“Cool by Adding Fluid Flow” on page 109.

1 Open the model busbar.mph that was created earlier. From the main menu, 
select File > Save As and rename the model busbar_II.mph.

2 In the Model Builder, 
right-click the Component 1 
node  and select Add 
Physics .

3 In the Add Physics window, 
under Structural Mechanics, select 
Solid Mechanics . 
To add this interface, you can 
right-click and select Add to 
Component or click the Add to 
Component button at the top of 
the window.

4 Close the Add Physics window and 
save the file. 

When adding additional physics, you need to make sure that materials 
included in the Materials node have all the required properties for the 
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selected physics. In this example, you already know that all properties are available 
for copper and titanium.

You can start by adding the effect of thermal expansion to the structural 
analysis. 

5 In the Model Builder right-click 
the Multiphysics node  and 
select Thermal Expansion . 
A Thermal Expansion node is 
added to the Model Builder.
You can also use the ribbon and 
select, from the Physics tab, 
Multiphysics >Thermal 
Expansion.
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6 In the Settings window for Thermal 
Expansion, from the Selection list 
select All domains. This will enable 
thermal expansion in the copper as 
well as in the titanium bolts.
The Thermal Expansion Properties 
section of this window shows 
information about the Coefficient of 
thermal expansion and the Strain 
reference temperature. The 
Coefficient of thermal expansion 
takes its value from the Materials 
node. The Strain reference 
temperature has a default value of 
293.15 K (room temperature) and 
defines the temperature for which 
there is no thermal expansion. The 
Thermal Expansion section at the 
bottom of the Settings windows 
shows which two physics interfaces 
define the physics for heat transfer 
and solid mechanics. This is useful in 
the case where there are more than 
one physics interface for heat transfer 
or solid mechanics in the model 
component. Keep all default settings 
in this window.
Next, constrain the busbar at the position of the titanium bolts.

7 In the model tree, right-click Solid Mechanics  and from the boundary level, 
select Fixed Constraint . A node with the same name is added to the tree.

8 Click the Fixed Constraint node . In the Graphics 
window, rotate the busbar to view the back. Click the 
circular surface of one of the bolts to add it to the 
Selection list. 
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9 Repeat this procedure for the remaining bolts to add boundaries 8, 15, and 43.

For easier management of 
multiple boundary selections, you 
can group boundaries into a 
user-defined Selection. Once you 
have selected boundaries 8, 15, 
and 43, click the Create Selection button  and give it a name such as 
Bolt top surfaces. 
This Selection is then added as a node under Component 1>Definitions 
and is accessible from the Selection list for all types of boundary 
conditions. You can use this technique to group Domains, Boundaries, 
Edges, and Points.

Next we update the Study to take the added physics into account.

SOLVING FOR JOULE HEATING AND THERMAL EXPANSION

The Joule heating effect is independent of the stresses and strains in the busbar, 
assuming small deformations and ignoring the effects of electric contact pressure. 
This means that you can run the simulation using the temperature as input to the 
structural analysis. In other words, the extended multiphysics problem is weakly 
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coupled. As such, you can solve it in two separate study steps to save computation 
time—one for Joule heating and a second one for structural analysis.
1 In the Model Builder, right-click Study 1  and 

select Study Steps > Stationary > Stationary  to add 
a second stationary study step.

When adding study steps you need to manually connect the correct 
physics with the correct study step. We shall start by disabling the 
structural analysis from the first step.

2 Under Study 1, click the Step 1: Stationary node .
3 In the Settings window for Stationary, locate the 

Physics and Variables Selection.

4 In the Solid Mechanics 
(solid) row under Solve for, 
click to change the check 
mark  to an  to remove 
Solid Mechanics from Study 
Step 1.

Now repeat these steps to remove Electric Currents (ec) and Heat Transfer in 
Solids (ht) from the second study step.

5 Under Study 1, click Step 2: Stationary 2 .

6 Under Physics and Variables 
Selection, in the Electric 
Currents (ec) and Heat 
Transfer in Solids (ht) rows, 
click to change the check 
mark  to an  to remove 
Joule heating from Study 
Step 2. 
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7 Right-click the Study 1 node  and select Compute  (or press F8 or click 
Compute in the ribbon) to solve.

Save the file busbar_II.mph, which now includes the Solid Mechanics interface 
and the additional study step. 

RESULTING DEFORMATION

Now add a displacement plot.
1 Under Results>3D Plot Group 4, click the Surface 1 node . 
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2 In the Settings window for Surface in 
the Expression section, click the Replace 
Expression button . 

From the context menu, select 
Model>Component 1>Solid 
Mechanics> Displacement> solid.disp - 
Total displacement.
You can also enter solid.disp in the 
Expression field.
Now, change to a more suitable unit. In 
the Settings window under Expression, 
from the Unit list select mm (or type mm 
in the field).

3 Click Range to expand that section. 
Click to clear the Manual color range 
check box.

The local displacement due to thermal expansion is displayed by COMSOL as 
a surface plot. Next we’ll add information about the busbar deformation.

4 In the Model Builder, under Results>3D Plot Group 4, right-click the Surface 
1 node  and add a Deformation node . The plot automatically updates in 
the Graphics window. Click the Go to Default 3D View button  so your view 
appears similar to the plot shown below.
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The deformations shown in the figure are highly amplified to make the 
very small distortions that actually take place more visible.

5 Save the busbar_II.mph file, which now includes a Surface plot with a 
Deformation.

You can also plot the von Mises and principal stresses to assess the 
structural integrity of the busbar and the bolts.

COOL BY ADDING FLUID FLOW

After analyzing the heat generated in the busbar and possibly the induced thermal 
expansion, you might want to investigate ways of cooling the busbar by letting air 
flow over its surfaces. These steps do not require any additional modules as the 
model only includes Joule heating without the previous thermal expansion 
analysis.

If you have the CFD Module, the Non-Isothermal Flow multiphysics 
interface is available. If you have the Heat Transfer Module, the Conjugate 
Heat Transfer multiphysics interface is available. Either one of these two 
interfaces automatically defines coupled heat transfer in solids and fluids 
including laminar or turbulent flow, whereas in this example, this is done 
manually and with limited functionality.

Adding fluid flow to the Joule heating model forms a new multiphysics coupling. 
To simulate the flow domain, you need to create an air box around the busbar. 
You can do this manually by altering the geometry from your first model or by 
opening an application library file. In this case, you will open a file with the box 
already created.
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After loading the geometry, you will learn how to simulate air flow according to 
this figure:

DEFINING INLET VELOCITY

Start by loading the geometry and adding a new parameter for the inlet flow 
velocity.
1 If you have just reopened the software, close the New window that opens 

automatically by clicking the Cancel button .

Air outlet

Air inlet
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2 Click the Home tab, and from the Windows menu select Application Libraries 
. Navigate to COMSOL Multiphysics> Multiphysics> busbar box.

Double-click to open the file, 
which contains the geometry in 
addition to the physics modeling 
steps completed through the end 
of the section “Customizing 
Materials” on page 98.

3 Under Global Definitions, click the Parameters node . 
4 In the Settings window for Parameters click the empty row just below the Vtot 

row. In the Name column, enter Vin. Enter 1e-1[m/s] in the Expression 
column and a description of your choice in the Description column, such as 
Inlet velocity.

5 Select File>Save As and save the model with a new name, busbar_box_I.mph. 

ADDING AIR

The next step is to add the material properties of air.
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1 From the Home tab, select Add Material  (or right-click the Materials node 
and select Add Material.)

2 In the Add Material window, expand 
the Built-In node. Right-click Air and 
select Add to Component 1. Close 
the Add Material window.

3 In the Model Builder under Materials, 
click the Air node . 

4 On the Graphics window toolbar, 
click Zoom Extents .

5 In the Graphics window, click the air 
box (Domain 1) to add it to the 
Selection list, which changes the 
color to blue. This step assigns the 
air material properties to the air box.

ADDING FLUID FLOW

Now add the physics of fluid flow.
1 In the model tree, right-click 

Component 1  and select Add Physics .
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2 In the Add Physics window under 
Fluid Flow>Single-Phase Flow, 
right-click Laminar Flow  and 
select  Add to Component. 
Laminar Flow will appear under 
Component 1 in the Model 
Builder. Close the Add Physics 
window.

3 On the Graphics toolbar, click the 
Transparency button . In 
addition, click the Wireframe 
Rendering button . These two 
settings make it easier to see inside 
the box. Toggle these on and off as needed during the modeling process to 
control the type of rendering used.
Now that you have added fluid flow to the model, you need to remove the air 
domain (Domain 1) from the Electric Currents (ec) interface (we are assuming 
that the air has no electric conductivity and hence no currents) and then couple 
the heat transfer part of the Joule heating multiphysics interface to the fluid 
flow.

4 In the Model Builder, select 
the Electric Currents (ec) 
node . In the Graphics 
window, move the mouse 
pointer over the air domain 
and click to remove it from 
the selection list. At this 
point, only the busbar 
should be selected and 
highlighted in blue.
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5 In the Model Builder, right-click Heat Transfer in Solids . In the first section 
of the context menu, the domain level , select Heat Transfer in Fluids.

6 In the Graphics window, 
click the air domain 
(Domain 1) to add it to 
the Selection list. 
Now couple the fluid flow 
and the heat transfer 
phenomena.

7 In the Settings window 
for Heat Transfer in Fluids under 
Model Inputs, select Velocity 
field (spf) from the Velocity field 
list. Then, select Absolute 
pressure (spf) from the Absolute 
pressure list.
This identifies the flow field and 
pressure from the Laminar Flow 
interface and couples it to heat 
transfer.

Now define the boundary conditions by specifying the inlet and outlet for the 
heat transfer in the fluid domain.
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8 In the Model Builder, right-click Heat Transfer in 
Solids . In the second section of the context 
menu, the boundary section , select 
Temperature. 
A Temperature node is added to the Model 
Builder.

9 In the Graphics window, 
click the inlet boundary, 
Boundary 2, to add it to the 
Selection list. 
This sets the inlet 
temperature to 293.15 K, 
the default setting. 
The graphics should look 
like the image to the right 
(it may look slightly 
different depending on 
whether you have 
Transparency and 
Wireframe Rendering on or 
off.) Continue by defining 
the outlet.

10In the Model Builder, right-click Heat Transfer in Solids . At the boundary 
level, select Outflow. An Outflow node  is added to the Model Builder.
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11In the Graphics window, 
click the outlet boundary, 
Boundary 5, to add it to 
the Selection list. Use the 
mouse scroll wheel to 
scroll in and highlight the 
boundary before selecting 
it, or use the up and down 
arrow keyboard buttons.

The settings for the busbar, the bolts, and the Electric Potential 1 and 
Ground 1 boundaries have retained the correct selection, even though you 
added the box geometry for the air domain. To confirm this, in the Model 
Builder under Electric Currents, click the Electric Potential 1 and the 
Ground 1 nodes to verify that they have the correct boundary selection.

Let’s continue with the flow settings. You need to indicate that fluid flow only 
takes place in the fluid domain and then set the inlet, outlet, and symmetry 
conditions.
 | 117



1 In the model tree, click the Laminar Flow node . In the Settings window for 
Laminar Flow click the Clear Selection button .

2 In the Graphics window, click the air box (Domain 1) to add it to the Selection.
It is good practice to verify that the Air 
material under the Materials node has all 
the properties that this multiphysics 
combination requires. In the model tree 
under Materials, click Air. In the Settings 
window for Material under Material Contents, verify that there are no 
missing properties, which are marked with a warning sign . The section 
“Materials” on page 61 has more information. 

Let’s continue with the boundaries.
3 In the Model Builder, right-click Laminar Flow  and 

at the boundary level select Inlet. An Inlet node  is 
added to the Model Builder. 
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4 In the Graphics window, 
click the inlet (Boundary 2) 
to add it to the Selection list.

5 In the Settings window for 
Inlet under Velocity in the U0 
field, enter Vin to set the 
Normal inflow velocity.

6 Right-click Laminar Flow  
and at the boundary level select 
Outlet . In the Graphics 
window, click the outlet 
(Boundary 5) to add it to the 
Selection list. Use the mouse 
scroll wheel or keyboard arrows 
to scroll in and highlight the 
boundary before selecting it.
The last step is to add symmetry 
boundaries. You can assume that 
the flow just outside of the faces 
of the channel is similar to the 
flow just inside these faces. This 
assumption can be correctly 
expressed by the symmetry 
condition.

7 Right-click Laminar Flow  and select Symmetry. A Symmetry node  is 
added to the sequence.

8 In the Graphics window, click each of the blue faces in the figure below 
(Boundaries 1, 3, 4, and 48) to add all of them to the Selection list. You may 
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need to use the mouse scroll wheel or rotate the geometry to select all of them.
Save the busbar_box_I.mph 
file, which now includes the 
Air material and Laminar 
Flow interface settings. 

When you know the 
boundaries, you can click 
the Paste Selection 
button  and enter the 
information. In this 
example, enter 1,3,4,48 in 
the Paste Selection window. 
Click OK and the boundaries are automatically added to the Selection list. 

COARSENING THE MESH

To get a quick solution, we will change the mesh slightly and make it coarser. The 
current mesh settings would take a relatively long time to solve, and you can 
always refine it later. 
1 In the Model Builder, expand the Mesh 1 node  and 

click the Size node .
120 | 



2 In the Settings window for Size 
under Element Size, click the 
Predefined button and ensure 
that Normal is selected.

3 Click the Build All button . The geometry displays with a mesh in the 
Graphics window (you may need to turn Transparency off to see the picture 
below.)

You can assume that the flow velocity is large enough to neglect the influence of 
the temperature increase in the flow field. 
It follows that you can solve for the flow field first and then solve for the 
temperature using the results from the flow field as input. This is implemented 
with a study sequence.

SOLVING FOR FLUID FLOW AND JOULE HEATING

When the flow field is solved before the temperature field it yields a weakly 
coupled multiphysics problem. The study sequence described in this section 
automatically solves such a weak coupling. 
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1 In the model tree, right-click Study 1  and select Study 
Steps>Stationary>Stationary  to add a second stationary study step to the 
Model Builder. 

Next, the correct physics needs to be connected with the correct study step. 
Start by disabling the Electric Currents (ec) and Heat Transfer in Solids (ht) 
interfaces associated with Joule heating from the first step.

2 Under Study 1, click Step 1: Stationary .

3 In the Settings window for Stationary locate the Physics and Variables Selection 
section. In both the Electric Currents (ec) and the Heat Transfer in Solids (ht) 
rows, click to change the check mark  to an  in the Solve for column, 
removing Joule heating from Step 1. 
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4 Repeat the step. Under Study 1, click Step 2: Stationary 2 . Under Physics 
and Variables Selection, in the Laminar Flow (spf) row, click in the Solve for 
column to change the check mark  to an .

5 Right-click the Study 1 node  and select Compute  (or press F8 or click 
Compute in the ribbon). This will now automatically create a new solver 
sequence that solves for laminar flow and then Joule heating. 

6 After the solution is complete, select the Temperature (ht) plot under the 
Results node in the Model Builder. If you don’t already have transparency on, 
click the Transparency button  on the Graphics toolbar to visualize the 
 | 123



temperature field inside the box. To zoom, middle-click and hold down the 
mouse button (or scroll wheel) while dragging the mouse.

The Temperature Surface plot that displays in the Graphics window shows the 
temperature in the busbar and in the surrounding box. You can also see that the 
temperature field is not smooth due to the relatively coarse mesh. A good 
strategy to get a smoother solution would be to refine the mesh to estimate the 
accuracy.

7 Save the busbar_box_I.mph file at this point so you can return to this file if 
you want. The next steps use the original busbar.mph file.

Parametric Sweeps

SWEEPING A GEOMETRIC PARAMETER

It is often useful to generate multiple instances of a design with the objective of 
meeting specific constraints. In the previous busbar example, a design goal might 
be to lower the operating temperature, or to decrease the current density. We will 
demonstrate the former. Since the current density depends on the geometry of the 
busbar, varying the width, wbb, should change the current density and, in turn, 
have some impact on the operating temperature. Let us run a parametric sweep on 
wbb to study this change. 
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ADDING A PARAMETRIC SWEEP

1 From the File menu, open the 
model file busbar.mph. If you 
didn’t save the model, you can also 
open it from the Application 
Libraries: File menu > Application 
Libraries > COMSOL 
Multiphysics > Multiphysics > 
busbar. In the Model Builder, 
right-click Study 1  and select 
Parametric Sweep . A Parametric 
Sweep node is added to the Model 
Builder sequence.

2 In the Settings window for Parametric Sweep, under the empty parameter table, 
click the Add button . From the Parameter names list in the table, select wbb. 

The Sweep type, available above the Parameter names, is used to control 
parametric sweeps with multiple parameters. You select between 
sweeping for All combinations of the given parameters or a subset of 
Specified combinations.
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3 Enter a range of parameter values to sweep the width of the busbar from 5 cm 
to 10 cm in 1 cm increments. There are different ways to enter this information:
- Copy and paste or enter range(0.05,0.01,0.1) into the Parameter value 

list field.
- Click the Range  button and 

enter the values in the Range 
dialog box. In the Start field, enter 
5e-2. In the Step field, enter 
1e-2, and in the Stop field, enter 
1e-1. Click Replace.

- In any of the methods, you can 
also use length units to override 
the default SI unit system using 
meters. Instead of 5e-2 you can 
enter 5[cm], similarly 1[cm] 
instead of 1e-2 and 10[cm] 
instead of 1e-1. You can also 
change the default unit system 
from the Settings window of the 
root node in the model tree.

Next, define an Average component coupling that can be used later to calculate 
the average temperature in the busbar.
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4 Under Component 1, right-click Definitions  and select Component 
Couplings>Average . 

5 In the Settings window for Average select All domains from the Selection list.

This creates an operator called aveop1. This operator is now available to 
calculate the average of any quantity defined on the selected domains. A little 
later this is used to calculate the average temperature, but it can also be used to 
calculate average electric potential, current density, and so forth.
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6 Select File>Save As to save the model with the new name, busbar_III.mph.
7 Right-click Study 1  and select Compute  to run the sweep or click 

Compute in the Home tab.

PARAMETRIC SWEEP RESULTS

Click the Temperature (ht) 1 node located under 
Results in the Model Builder. 
The plot that displays in the Graphics window shows 
the temperature in the wider busbar using the last 
parameter value, wbb=0.1[m] (10[cm]). Select 
Zoom Extents  from the Graphics window toolbar 
so that you can see the entire plot. The resulting plot 
is rather uniform in color, so we need to change the 
maximum color range.

1 Under the Temperature (ht) 1 node, click the Surface node . 
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2 In the Settings window for Surface click 
Range to expand the section. Select the 
Manual color range check box. Enter 
309.4 in the Maximum field (replace 
the default). 

3 The Temperature (ht) 1 plot is updated 
in the Graphics window for 
wbb=0.1[m] (10[cm]). 

Compare the wider busbar plot to the temperature for wbb=0.05[m] (5[cm]).

1 In the Model Builder, click the first Temperature (ht) node . 
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2 In the Settings window for 
3D Plot Group select 
Study 1/Parametric 
Solutions 1 from the Data 
set list. This data set contains 
the results from the 
parametric sweep. 

3 In the Parameter value list, 
select 0.05 (which represents 
wbb=5 cm). Click the Plot 
button . Click the Zoom Extents button  on the Graphics window toolbar.

The Temperature (ht) plot is updated for wbb=0.05[m] (5[cm]). Note that if 
you have updated the color range for this plot already, your plot should look 
similar to the one below. If not, follow the subsequent steps.

Like the wider busbar, the plot may be quite uniform in color, so change the 
maximum color range.
1 Under the first Temperature (ht) node, click the Surface node . 
2 In the Settings window for Surface click Range to expand the section (if it is not 

already expanded). Select the Manual color range check box. 
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3 Enter 323 in the Maximum field (replace the default) to plot wbb at 5 cm. 
The Temperature (ht) plot is updated in the Graphics window for 
wbb=0.05[m] (5[cm]). 
Click the first and second Temperature plot nodes to compare the plots in the 
Graphics window. The maximum temperature decreases from 331 K to 318 K 
as the width of the busbar increases from 5 cm to 10 cm. 

ADDING MORE PLOTS

To further analyze these results, you can plot the average temperature for each 
width.
1 Right-click Results  and add a 1D Plot Group . 

2 In the Settings window for 1D Plot Group select Study 1/Parametric 
Solutions 1 from the Data set list.
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3 In the Model Builder, right-click 1D Plot Group 8 and add a Global  node. 

4 In the Settings window for Global under y-Axis Data, click the first row in the 
Expressions column and enter aveop1(T). This operator is the one we defined 
on page 126 for later use. You use a similar syntax to calculate the average of 
other quantities.

To use a coupling operator without solving, you can select the option 
Update Solution that is available by right-clicking a Study node.

5 Click to expand the Legends section. Select the Expression check box.
This adds a legend at the top right corner of the graph.
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6 Click the Plot button  and save the busbar_III.mph model with these 
additional plots that use the parametric sweep results. 

In the plot, the average temperature also decreases as the width increases. This 
indicates that the goal of a lower operating temperature would be fulfilled by using 
a wider busbar.
The subject of parametric sweeps raises the question of parallel computing; it 
would be efficient if all parameters were solved simultaneously.

Paral lel  Computing

COMSOL supports most forms of parallel computing including shared memory 
parallelism for multicore processors and high performance computing (HPC) for 
clusters and clouds. All COMSOL licenses are multicore enabled. For cluster or 
cloud computing, including parallelized sweeps, a Floating Network License is 
needed.
You can use clusters or clouds either for Cluster Sweep or for Cluster Computing. 
If you have a Floating Network License, these two options are available by 
right-clicking the Study node. However, you first need to enable Advanced Study 
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Options by clicking the Show button  on the Model Builder toolbar and 
selecting Advanced Study Options. 

CLUSTER SWEEP

Cluster Sweep is used for solving several models in parallel where each model has 
a different set of Parameters. This can be seen as a generalization of Parametric 
Sweep. Right-click the Study 1 node to add a Cluster Sweep node.

The Study Settings for Cluster Sweep are similar to that of Parametric Sweep, but 
additional settings are required for the cluster or cloud being used. The picture 
above shows how the top of the Settings window for Cluster Sweep would look 
for the same sweep as defined in “Parametric Sweeps” on page 123.
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CLUSTER COMPUTING

You can also utilize a cluster or cloud to solve a single large model using 
distributed memory. For maximum performance, the COMSOL cluster 
implementation can utilize shared-memory multicore processing on each node in 
combination with the Message Passing Interface (MPI) based distributed memory 
model. This is also known as hybrid parallelism and brings a major performance 
boost by making the most out of the computational power available.
Right-click the Study node to add a Cluster Computing node. A Cluster 
Computing node cannot be used in combination with a Cluster Sweep. You will 
be asked if you want to remove the Cluster Sweep before proceeding, select Yes. 
The Settings window for Cluster Computing, shown below, helps to manage the 
simulation with settings for the cluster or cloud.
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You choose the type of cluster job you want to perform from the Cluster type list. 
COMSOL supports Windows® Compute Cluster Server (WCCS) 2003, 
Windows® HPC Server (HPCS) 2008, Open Grid Scheduler/ Grid Engine 
(OGS/GE), SLURM, or Not distributed. 
To learn more about running COMSOL in parallel, see the COMSOL 
Multiphysics Reference Manual.
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Appendix A—Building a Geometry

This section details how to create the busbar geometry using the built-in geometry 
tools in COMSOL. The step-by-step instructions take you through the 
construction of the geometry using the parameters set up in the Global Definitions 
section. Using parameterized dimensions helps to produce what-if analyses and 
geometric parametric sweeps.
As an alternative to building the geometry in COMSOL, you can import a 
geometry from a CAD package. The optional CAD Import Module supports 
many CAD file formats. Moreover, several add-on products are available that 
provide bidirectional interfaces to common CAD software packages. See 
“Appendix E—Connecting with LiveLink™ Add-Ons” on page 174 for a list.
If you have not done so already, start with “Example 2: The Busbar—A 
Multiphysics Model” on page 53. Follow the steps under the Model Wizard to 
add the physics and study and then follow the steps under Global Definitions to 
add the parameters. Return to this section to learn about geometry modeling. The 
first step in the geometry sequence is to draw the profile of the busbar.
1 Under Component 1, right-click 

Geometry 1  and select 
Work Plane . In the Settings 
window for Work Plane:
- Select xz-plane from the Plane list.
- Click the Show Work Plane 

button  on the Settings window 
for Work Plane toolbar.

Continue by editing the axis and grid 
settings in Work Plane 1.
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2 In the Model Builder, expand the View 2 node  and click Axis .

3 In the Settings window for Axis:
Under Axis:
- In the x minimum and y minimum 

fields, enter -0.01.
- In the x maximum and y maximum 

fields, enter 0.11.
Under Grid:
- Select the Manual Spacing check box.
- In the x spacing and y spacing fields, 

enter 5e-3.
4 Click the Update button  on the 

toolbar.
Note that the values you type will 
automatically adjust slightly after you click 
Update to adapt to the screen aspect ratio.

You can use interactive drawing to create a 
geometry using the drawing tools from the Work Plane tab in the ribbon while 
pointing and clicking in the Graphics window. 

You can also right-click the Plane Geometry node  under Work Plane 1  to 
add geometry objects to the geometry sequence.

In the next few steps we create a profile of the busbar.

Work Plane Tab

Geometry Primitives
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5 In the Model Builder under Work Plane 1, right-click Plane Geometry  and 
select Rectangle . 
In the Settings window for Rectangle 
under Size, enter:
- L+2*tbb in the Width field.
- 0.1[m] in the Height field.
Click the Build Selected button .

6 Create a second rectangle. Under Work 
Plane 1, right-click Plane Geometry  
and select Rectangle . 
Under Size, enter:
- L+tbb in the Width field
- 0.1[m]-tbb in the Height field.
Under Position, enter:
- tbb in the yw field.
Click the Build Selected button .

Use the Boolean Difference operation 
to subtract the second rectangle from 
the first one. 

7 Under Work Plane 1, right-click Plane 
Geometry  and select Booleans and 
Partitions > Difference . In the Graphics window, click r1 (the larger of the 
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two rectangles) to add it to the Objects to add list in the Settings window for 
Difference.

To help select the geometry you can display geometry labels in the 
Graphics window. In the Model Builder under Geometry 
1>WorkPlane 1, click the View 2 node. Go to the Settings window for 
View and select the Show geometry labels check box.

8 Click the Difference node. In the 
Settings window for Difference, click 
the Active selection button to the left of 
the Objects to subtract list. Select the 
smaller rectangle, r2, by using the 
mouse scroll wheel or arrow keys to 
cycle through the overlapping 
rectangles to first highlight it, and then 
click on it to select it.
Click Build Selected .

Another way to select r2 in the Graphics 
window is to use the Selection List 
feature. Go to the Home tab in the 
ribbon and select Windows > Selection 
List. In the Selection List click to 
highlight r2 (solid). Then, right-click r2 
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(solid) in the list and select Add to Selection to add it to the Objects to subtract 
list. Right-click on the Selection List window title and select Close.

After building the selected geometry, you should have a backward-facing, 
L-shaped profile. Continue by rounding the corners of the L-shaped profile.

9 Under Work Plane 1, right-click Plane Geometry  and select Fillet . 
Select point 3 to add it to the Vertices to fillet list. There are different ways to 
add points:
- In the Graphics window, click point 3 (in the inner right corner) to add it to 

the Vertices to fillet list. 
- From the Home tab, select Windows > Selection List. In the Selection List 

window, click 3. The corresponding point is highlighted in the Graphics 
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window. Click the Add to Selection button  in the Settings window for 
Fillet or right-click in the Selection List.

10Enter tbb in the Radius field. Click Build Selected . 
This takes care of the inner corner.

11For the outer corner, right-click Plane 
Geometry  and select Fillet . 

12In the Graphics window, click point 6, 
the outer corner, to add it to the Vertices 
to fillet list.

13Enter 2*tbb in the Radius field. Click 
Build Selected .
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The result should match this figure:

Next you extrude the work plane to create the 3D busbar geometry.
1 In the Model Builder, right-click Work Plane 1  and select Extrude . In the 

Settings window for Extrude enter wbb in the Distances from Plane table 
(replace the default) to extrude to the width of the profile. 

The table allows you to enter several values in order to create sandwich 
structures with different materials. In this case, only one extruded layer is 
needed.
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2 Click Build Selected  and then click the Zoom Extents  button on the 
Graphics toolbar. Click the Save button  and name the model busbar.mph (if 
you have not already done so). 

Next, create the titanium bolts by extruding two circles drawn in two work 
planes. 

3 In the Model Builder, right-click Geometry 1  and add a Work Plane . A 
Work Plane 2 node is added. In the Settings window for Work Plane, under 
Plane Definition, select Face parallel as the Plane type.
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4 In the Graphics window, click face 8 as shown in the figure below, to add it to 
the Planar face list in the Settings window for Work Plane. 
Face number 8 is now highlighted in blue and the work plane is positioned on 
top of the face.

5 Click the Show Work Plane button  to draw the first circle representing the 
position of the first bolt. Click the Zoom Extents button  on the Graphics 
toolbar.

6 Under Work Plane 2, right-click 
Plane Geometry  and select 
Circle .
In the Settings window for Circle:
- Under Size and Shape, in the 

Radius field, enter rad_1.
- Under Position, the default xw 

and yw coordinates (0, 0) are 
good.

Click Build Selected . 

Face 8
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Continue creating the bolt by adding an extrude operation. 
1 In the Model Builder, right-click Work Plane 2  and select Extrude . In the 

Settings window for Extrude, in the first row of the Distances from Plane table, 
enter -2*tbb to extrude the circle. 

2 Click the Build Selected button  to create the cylindrical part of the titanium 
bolt that runs through the busbar. 

Draw the two remaining bolts.
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3 Right-click Geometry 1  and select Work Plane . A Work Plane 3 node is 
added. In the Settings window for Work Plane, for Work Plane 3, select Face 
parallel as the Plane type. 

4 In the Graphics window, click Face 4 as shown in the figure, to add it to the 
Planar face list in the Settings window for Work Plane. 

5 Click the Show Work Plane button  on the Settings window for Work Plane 
and the Zoom Extents button  on the Graphics toolbar to get a better view 
of the geometry. 
To parameterize the position of the two remaining bolts, add the circles that 
form the cross sections of the bolts.
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6 Under Work Plane 3, right-click Plane Geometry  and select Circle . 
In the Settings window for Circle:
- Under Size and Shape, enter rad_1 in 

the Radius field. 
- Under Position, enter -L/2+1.5[cm] 

in the xw field and -wbb/4 in the yw 
field. 

Click Build Selected .

Copy the circle that you just created to 
generate the third bolt in the busbar.

7 Under Work Plane 3, right-click Plane 
Geometry  and select 
Transforms>Copy . 

8 In the Graphics window, click the circle 
c1 to select and add the circle to the 
Input objects list in the Settings 
window for Copy. 

9 In the Settings window for Copy under 
Displacement, enter wbb/2 in the yw 
field.
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10Click Build Selected  and click the Zoom Extents button  on the Graphics 
toolbar.
Your geometry, as shown in the work plane, should match this figure so far. 

Continue by extruding the circles.
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11In the Model Builder, right-click Work Plane 3  and select Extrude . In the 
Settings window for Extrude, in the first row of the Distances from Plane table, 
enter -2*tbb (replace the default). Click Build All Objects . 

The geometry and geometry sequence should match the figures below. Click 
the Save button  and name the model busbar.mph.
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CREATING PARTS AND USING THE PART LIBRARIES

After setting up the busbar or other geometry, it’s convenient to be able to save 
it for future use, avoiding unnecessary work. In the steps you’ve just completed, 
the geometry was stored directly in the COMSOL model file that will also be 
used to set up the complete busbar model. Instead, you can also create a 
reusable part that can serve as a building block of a more complex COMSOL 
model geometry, which is stored in a separate file accessible through the Part 
Libraries.

While building the busbar geometry, you were using features from the 
Geometry and Workplane tabs. A Parts menu is located in the Other group in 
these tabs.

Through the Parts menu, you can choose to create or load a part, or add a part to 
the model geometry by selecting one from the Part Libraries. Several Part 
Libraries are already provided with the software by default. When new parts are 
created, they are added under a Part’s parent node in the Global Definitions 
section of the model tree. For additional information on working with Parts and 
the Part Libraries, see the COMSOL Multiphysics Reference Manual.

To continue with the busbar tutorial, return to the section “Materials” on 
page 61.
 | 151



Appendix B—Keyboard and Mouse Shortcuts

SHORTCUT (WINDOWS, LINUX) SHORTCUT (OS X) ACTION

F1 F1 Display help for the selected node 
or window

Ctrl+F1 Command+F1 Open the COMSOL 
Documentation front page in an 
external window

F2 F2 Rename the selected node, file, or 
folder

F3 F3 Disable selected nodes

F4 F4 Enable selected nodes

F5 F5 Update the Data Sets Solutions with 
respect to any new Global 
Definitions and Definitions without 
re-solving the model

F6 F6 Build the preceding node in the 
geometry branch

F7 F7 Build the selected node in the 
geometry and mesh branches, 
compute the selected study step, or 
compute the selected node in the 
solver sequence

F8 F8 Build the geometry, build the mesh, 
compute the entire solver sequence, 
update results data, or update the 
plot

Del Del Delete selected nodes

Left arrow (Windows); Shift + 
left arrow (Linux)

Left arrow Collapse a branch in the model tree

Right arrow (Windows); Shift 
+ right arrow (Linux)

Right arrow Expand a branch in the model tree

Up arrow Up arrow Move to the node above in the 
model tree

Down arrow Down arrow Move to the node below in the 
model tree

Alt+left arrow Ctrl+left arrow Move to the previously selected 
node in the model tree
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Alt+right arrow Ctrl+right arrow Move to the next selected node in 
the model tree

Ctrl+A Command+A Select all domains, boundaries, 
edges, or points; select all cells in a 
table

Ctrl+C Command+C Copy text in fields

Ctrl+D Command+D Clear the selection of domains, 
boundaries, edges, or points

Ctrl+F Command+F [[check]] Find a search string

Ctrl+N Command+N New model

Ctrl+O Command+O Open a model file

Ctrl+P Command+P Print the contents of the plot 
window

Ctrl+S Command+S Save a model file

Ctrl+V Command+V Paste copied text

Ctrl+Y Ctrl+Shift+Z Redo the last undone operation

Ctrl+Z Command+Z Undo the last operation

Ctrl+up arrow Command+up arrow Move a definitions node, geometry 
node, physics node (except default 
nodes), material node, mesh node, 
study step node, or results node up 
one step

Ctrl+down arrow Command+down 
arrow

Move a definitions node, geometry 
node, physics node (except default 
nodes), material node, mesh node, 
study step node, or results node 
down one step

Ctrl+Tab Ctrl+Tab Switch focus to the next window on 
the desktop

Ctrl+Shift+Tab Ctrl+Shift+Tab Switch focus to the previous 
window on the desktop

Ctrl+Alt+A Not available Go to Application Builder

Ctrl+Alt+M Not available Go to Model Builder

Ctrl+Alt+left arrow Command+Alt+left 
arrow

Switch focus to the Model Builder 
window

Ctrl+Alt+right arrow Command+Alt+right 
arrow

Switch focus to the Settings window

SHORTCUT (WINDOWS, LINUX) SHORTCUT (OS X) ACTION
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Ctrl+Alt+up arrow Command+Alt+up 
arrow

Switch focus to the previous section 
in the Settings window

Ctrl+Alt+down arrow Command+Alt+down 
arrow

Switch focus to the next section in 
the Settings window

Shift+F10 or

(Windows only) Menu key

Ctrl+F10 Open the context menu

Ctrl+Space Ctrl+Space Open list of predefined quantities 
for insertion in Expression fields for 
plotting and results evaluation

Left-click and hold down the 
mouse button while dragging 
the mouse.

Same as for Windows, 
only available for 
two-button mouse.

Rotate the scene around the axes 
parallel to the screen X- and Y-axes 
with the origin at the scene rotation 
point.

Right-click and hold down the 
mouse button while dragging 
the mouse.

Same as for Windows, 
only available for 
two-button mouse.

Move the visible frame on the image 
plane in any direction.

Middle-click and hold down the 
mouse button while dragging 
the mouse. 

Same as for Windows, 
only available for 
two-button mouse.

The scene is zoomed in/out around 
the mouse position where the 
action started.

Press Ctrl and left-click. While 
holding down the key and 
button, drag the mouse.

Same as for Windows, 
only available for 
two-button mouse.

Tilt and pan the camera by rotating 
about the X- and Y axes in the 
image plane.

Press Ctrl and right-click. While 
holding down the key and 
button, drag the mouse. 

Same as for Windows, 
only available for 
two-button mouse.

Move the camera in the plane 
parallel to the image plane.

Press Ctrl and middle-click. 
While holding down the key 
and button drag the mouse. 

Same as for Windows, 
only available for 
two-button mouse.

Move the camera into and away 
from the object (dolly in/out).

Press Ctrl+Alt and left-click. 
While holding down the keys 
and button, drag the mouse. 

Same as for Windows, 
only available for 
two-button mouse.

Rotate the camera around the axis.

Press Alt and left-click. While 
holding down the key and 
button, drag the mouse.

Same as for Windows, 
only available for 
two-button mouse.

Rotate the camera about its axis 
between the camera and the scene 
rotation point (roll direction).

SHORTCUT (WINDOWS, LINUX) SHORTCUT (OS X) ACTION
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Press Alt and right-click. While 
holding down the key and 
button, drag the mouse. 

Same as for Windows, 
only available for 
two-button mouse.

Move the scene in the plane 
orthogonal to the axis between the 
camera and the scene rotation 
point.

Press Alt and middle-click. 
While holding down the key 
and button, drag the mouse.

Same as for Windows, 
only available for 
two-button mouse.

Move the camera along the axis 
between the camera and the scene 
rotation point.

SHORTCUT (WINDOWS, LINUX) SHORTCUT (OS X) ACTION
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Appendix C—Language Elements and Reserved Names

Building a model tree in COMSOL is equivalent to graphically programming a 
sequence of operations. Saving as model file for MATLAB® or for Java® outputs 
the sequence of operations as a list of traditional programming statements. In this 
section we will give an overview of the following element categories as defined by 
the underlying COMSOL language:
• Constants
• Variables
• Functions
• Operators
• Expressions

These language elements are built-in or user-defined. Operators cannot be 
user-defined. Expressions are always user-defined.

ABOUT RESERVED NAMES

Built-in elements have reserved names, names that cannot be redefined by the 
user. If you try to use a reserved name for a user-defined variable, parameter, or 
function, the text where you enter the name will turn orange and you will get a 
tooltip error message if you select the text string. Reserved function names are 
reserved only for function names, which means that such names can be used for 
variable and parameter names, and vice versa. In the following pages, we list the 
most commonly used built-in elements and hence those reserved names. A more 
exhaustive list of built-in elements can be found in the COMSOL Multiphysics 
Reference Manual.

VARIABLES USED IN APPLICATIONS

Model parameters and variables can be used in applications. For example, you can 
let the user of an application change the value of a parameter. In addition, variables 
to be used in applications can be defined in the Application Builder under the 
Declarations node. Such variables are available globally in form objects and 
methods but cannot be used in the Model Builder.

Constants and Parameters

There are three different types of constants: built-in mathematical and numerical 
constants, built-in physical constants, and parameters. Parameters are user-defined 
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constants which can vary over parameter sweeps. Constants are scalar valued. The 
tables below list the built-in mathematical and numerical constants as well as 
built-in physical constants. Constants and parameters can have units.
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BUILT-IN MATHEMATICAL AND NUMERICAL CONSTANTS

BUILT-IN PHYSICAL CONSTANTS

DESCRIPTION NAME VALUE

Floating point relative accuracy for double 
floating point numbers, also known as 
machine epsilon

eps 2-52 (~2.2204·10-16)

The imaginary unit i, j i, sqrt(-1)

Infinity, ∞ inf, Inf A value larger 
than what can be 
handled with 
floating point 
representation

Not-a-number NaN, nan An undefined or 
unrepresentable value 
such as the result of 0/0 
or inf/inf

π pi 3.141592653589793

DESCRIPTION NAME VALUE

Acceleration of gravity g_const 9.80665[m/s^2]

Avogadro constant N_A_const 6.02214129e23[1/mol]

Boltzmann constant k_B_const 1.3806488e-23[J/K]

Characteristic impedance 
of vacuum (impedance of 
free space)

Z0_const 376.73031346177066[ohm]

Electron mass me_const 9.10938291e-31[kg]

Elementary charge e_const 1.602176565e-19[C]

Faraday constant F_const 96485.3365[C/mol]

Fine-structure constant alpha_const 7.2973525698e-3

Gravitational constant G_const 6.67384e-11[m^3/(kg*s^2)]

Molar volume of ideal gas 
(at 273.15 K and 1 atm)

V_m_const 2.2413968e-2[m^3/mol]

Neutron mass mn_const 1.674927351e-27[kg]

Permeability of vacuum 
(magnetic constant)

mu0_const 4*pi*1e-7[H/m]
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PARAMETERS

Parameters are user-defined constant scalars in the Global Definitions branch in 
the model tree. Example uses are:
• Parameterizing geometric dimensions
• Parameterizing mesh element sizes
• Defining parameters to be used in parametric sweeps

A parameter can be defined as an expression in terms of numbers, parameters, 
built-in constants, and built-in functions of parameters and built-in constants. 
Parameters should be assigned a unit, using [], unless they are dimensionless.

Variables

There are two types of variables: built-in and user-defined. Variables can be scalars 
or fields. Variables can have units. 
Note: There is a group of user-defined variables of special interest. Spatial 
coordinate variables and dependent variables. These variables have default names 
based on the space dimension of the geometry and the physics interface 
respectively. As a result of the names chosen for these variables, a list of built-in 
variables will be created by COMSOL: the first and second order derivatives with 
respect to space and time.

Permittivity of vacuum 
(electric constant)

epsilon0_const 8.854187817000001e-12[F/m]

Planck’s constant h_const 6.62606957e-34[J*s]

Planck’s constant over 2 pi hbar_const 1.05457172533629e-34[J*s]

Proton mass mp_const 1.672621777e-27[kg]

Speed of light in vacuum c_const 299792458[m/s]

Stefan-Boltzmann 
constant

sigma_const 5.670373e-8[W/(m^2*K^4)]

Universal gas constant R_const 8.3144621[J/(mol*K)]

Wien displacement law 
constant

b_const 2.8977721e-3[m*K]

DESCRIPTION NAME VALUE
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BUILT-IN VARIABLES

USER-DEFINED VARIABLES THAT GENERATE BUILT-IN VARIABLES

Example: T is the name for the temperature in a 2D, time-dependent heat transfer 
model, x and y are the spatial coordinate names. In this case, the following built-in 
variables will be generated: T, Tx, Ty, Txx, Txy, Tyx, Tyy, Tt, Txt, Tyt, Txxt, 
Txyt, Tyxt, Tyyt, Ttt, Txtt, Tytt, Txxtt, Txytt, Tyxtt, and Tyytt. Here, Tx 
corresponds to the partial derivative of the temperature T with respect to x, and 
Ttt corresponds to the second-order time derivative of T, and so on. If the spatial 
coordinate variables have other names—for example, psi and chi—then Txy 
would be Tpsichi, and Txt would be Tpsit. (The time variable t is built-in; the 
user cannot change its name.)

NAME DESCRIPTION TYPE

t Time Scalar

freq Frequency Scalar

lambda Eigenvalue Scalar

phase Phase angle Scalar

numberofdofs Number of degrees of freedom Scalar

h Mesh element size (length of the longest edge of 
the element)

Field

meshtype Mesh type index for the mesh element; this is the 
number of edges in the element.

Field

meshelement Mesh element number Field

dvol Volume scale factor variable; this is the 
determinant of the Jacobian matrix for the 
mapping from local (element) coordinates to 
global coordinates.

Field

qual A mesh quality measure between 0 (poor quality) 
and 1 (perfect quality)

Field

DEFAULT NAME DESCRIPTION TYPE

x, y, z Spatial coordinates (Cartesian) Field

r, phi, z Spatial coordinates (Cylindrical) Field

u, T, etc. Dependent variables (Solution) Field
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Functions

There are two types of functions: built-in and user-defined. Functions can be 
scalar valued or field valued depending on the input argument(s). Some functions 
can have units for both input and output arguments.

BUILT-IN MATHEMATICAL FUNCTIONS

These functions do not have units for their input or output arguments.

NAME DESCRIPTION SYNTAX EXAMPLE

abs Absolute value abs(x)

acos Inverse cosine (in radians) acos(x)

acosh Inverse hyperbolic cosine acosh(x)

acot Inverse cotangent (in radians) acot(x)

acoth Inverse hyperbolic cotangent acoth(x)

acsc Inverse cosecant (in radians) acsc(x)

acsch Inverse hyperbolic cosecant acsch(x)

arg Phase angle (in radians) arg(x)

asec Inverse secant (in radians) asec(x)

asech Inverse hyperbolic secant asech(x)

asin Inverse sine (in radians) asin(x)

asinh Inverse hyperbolic sine asinh(x)

atan Inverse tangent (in radians) atan(x)

atan2 Four-quadrant inverse tangent (in radians) atan2(y,x)

atanh Inverse hyperbolic tangent atanh(x)

besselj Bessel function of the first kind besselj(a,x)

bessely Bessel function of the second kind bessely(a,x)

besseli Modified Bessel function of the first kind besseli(a,x)

besselk Modified Bessel function of the second kind besselk(a,x)

ceil Nearest following integer ceil(x)

conj Complex conjugate conj(x)

cos Cosine cos(x)

cosh Hyperbolic cosine cosh(x)

cot Cotangent cot(x)

coth Hyperbolic cotangent coth(x)
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BUILT-IN OPERATOR FUNCTIONS

These built-in functions behave differently than the built-in mathematical 
functions. They may not belong in an introductory text but are listed to complete 

csc Cosecant csc(x)

csch Hyperbolic cosecant csch(x)

erf Error function erf(x)

exp Exponential exp(x)

floor Nearest previous integer floor(x)

gamma Gamma function gamma(x)

imag Imaginary part imag(u)

log Natural logarithm log(x)

log10 Base-10 logarithm log10(x)

log2 Base-2 logarithm log2(x)

max Maximum of two arguments max(a,b)

min Minimum of two arguments min(a,b)

mod Modulo operator mod(a,b)

psi Psi function and its derivatives psi(x,k)

range Create a range of numbers range(a,step,b)

real Real part real(u)

round Round to closest integer round(x)

sec Secant sec(x)

sech Hyperbolic secant sech(x)

sign Signum function sign(u)

sin Sine sin(x)

sinh Hyperbolic sine sinh(x)

sqrt Square root sqrt(x)

tan Tangent tan(x)

tanh Hyperbolic tangent tanh(x)

NAME DESCRIPTION SYNTAX EXAMPLE
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the list of reserved names. For more information see the COMSOL Multiphysics 
Reference Manual.

NAME NAME NAME NAME

adj dtang linsol sens

at emetric lintotal shapeorder

ballavg env lintotalavg side

ballint error lintotalpeak sphavg

bdf fsens lintotalrms sphint

bndenv fsensimag linzero subst

centroid if mean sum

circavg integrate noenv test

circint isdefined nojac timeavg

circumcenter pd timeint

d isinf ppr try_catch

depends islinear pprint up

dest isnan prev var

diskavg jacdepends reacf with

diskint lindev realdot

down linper residual

linpoint scope.ati
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USER-DEFINED FUNCTIONS

A user-defined function can be defined in the Global Definitions or Component 
Definitions branch of the model tree by selecting a template from the Functions 
menu and entering settings to define the name and detailed shape of the function.

TEMPLATE NAME ARGUMENTS AND DEFINITION SYNTAX EXAMPLE

Analytic The function name is its identifier, 
for example an1.

The function is a mathematical 
expression of its arguments.

Example: Given the arguments x 
and y, its definition is 
sin(x)*cos(y).

The function has an arbitrary 
number of arguments.

The name of the function with 
comma-separated arguments within 
parenthesis. For example:

an1(x,y)

Elevation The function name is its identifier, 
for example elev1.

Used to import geospatial elevation 
data from digital elevation models 
and map the elevation data to a 
function of x and y. A DEM file 
contains elevation data for a portion 
of the Earth’s surface. The resulting 
function behaves essentially like a 
grid-based interpolation function.

The name of the function with 
comma-separated arguments within 
parenthesis. For example:

elev1(x,y)

Gaussian Pulse The function name is its identifier, 
for example gp1.

The Gaussian pulse function defines 
a bell-shaped curve according to the 
expression

It is defined by the mean parameter, 
x0, and the standard deviation, σ.

The function has one argument.

The name of the function with a 
single argument within parenthesis. 
For example:

gp1(x)

y x( ) 1
σ 2π
---------------e

x x0–( )2–

2σ2
------------------------

=
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Image The function name is its identifier, 
for example im1.

Used to import an image (in BMP, 
JPEG, PNG, or GIF format) and map 
the image’s RGB data to a scalar 
(single channel) function output 
value. By default the function’s 
output uses the mapping 
(R+G+B)/3.

The name of the function with 
comma-separated arguments within 
parenthesis. For example:

im1(x,y)

Interpolation The function name is its identifier, 
for example int1.

An interpolation function is defined 
by a table or file containing the 
values of the function in discrete 
points.

The file formats are the following: 
spreadsheet, grid, or sectionwise.

The function has one to three 
arguments.

The name of the function with 
comma-separated arguments within 
parenthesis. For example:

int1(x,y,z)

Piecewise The function name is its identifier, 
for example pw1.

A piecewise function is created by 
splicing together several functions, 
each defined on one interval. Define 
the argument, extrapolation and 
smoothing methods, and the 
functions and their intervals. 

This function has one argument with 
different definitions on different 
intervals, which must not overlap or 
have any holes between them. 

The name of the function with a 
single argument within parenthesis. 
For example:

pw1(x)

Ramp The function name is its identifier, 
for example rm1.

A ramp function is a linear increase 
with a user-defined slope that begins 
at some specified time. 

The function has one argument. It 
can also be smoothed.

The name of the function with a 
single argument within parenthesis. 
For example:

rm1(x)

TEMPLATE NAME ARGUMENTS AND DEFINITION SYNTAX EXAMPLE
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Random The function name is its identifier, 
for example rn1.

A random function generates white 
noise with uniform or normal 
distribution and has one or more 
arguments to simulate white noise.

The function has arbitrary number 
of arguments.

The name of the function with 
comma-separated arguments within 
parenthesis. For example:

rn1(x,y)
The arguments x and y are used as a 
random seeds for the random 
function.

Rectangle The function name is its identifier, 
for example rect1.

A rectangle function is 1 in an 
interval and 0 everywhere else.

The function has one argument.

The name of the function with a 
single argument within parenthesis. 
For example:

rect1(x)

Step The function name is its identifier, 
for example step1.

A step function is a sharp transition 
from 0 to some other value 
(amplitude) at some location.

The function has one argument. It 
can also be smoothed.

The name of the function with a 
single argument within parenthesis. 
For example:

step1(x)

Triangle The function name is its identifier, 
for example tri1.

A triangle function is a linear 
increase and linear decline within an 
interval and 0 everywhere else. 

The function has one argument. It 
can also be smoothed.

The name of the function with a 
single argument within parenthesis. 
For example:

tri1(x)

Waveform The function name is its identifier, 
for example wv1.

A waveform function is a periodic 
function with one of several 
characteristic shapes: sawtooth, sine, 
square, or triangle.

The function has one argument. It 
can also be smoothed.

The name of the function with a 
single argument within parenthesis. 
For example:

wv1(x)

TEMPLATE NAME ARGUMENTS AND DEFINITION SYNTAX EXAMPLE
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External (Global 
Definitions only)

An external function defines an 
interface to one or more functions 
written in the C language (which 
can be a wrapper function 
interfacing source code written in 
for example Fortran). Such an 
external function can be used, for 
example, to interface a user-created 
shared library. Note that the 
extension of a shared library file 
depends on the platform: .dll 
(Windows), .so (Linux), or .dylib 
(OS X).

The name of the function and the 
appropriate number of arguments 
within parenthesis. For example:

myextfunc(a,b)

MATLAB® 
(Global 
Definitions only)

A MATLAB® function interfaces 
one or more functions written in 
the MATLAB® language. Such 
functions can be used as any other 
function defined in COMSOL 
provided LiveLink™ for MATLAB® 
and MATLAB® are installed. 
(MATLAB® functions are evaluated 
by MATLAB® at runtime.)

The name of the function and the 
appropriate number of arguments 
within parenthesis. For example:

mymatlabfunc(a,b)

TEMPLATE NAME ARGUMENTS AND DEFINITION SYNTAX EXAMPLE
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Unary and Binary Operators

Expressions

PARAMETERS

A parameter expression can contain: numbers, parameters, built-in constants, 
built-in functions of parameter expressions, unary and binary operators. 
Parameters can have units.

VARIABLES

A variable expression can contain: numbers, parameters, constants, variables, 
functions of variable expressions, unary and binary operators. Variables can have 
units.

FUNCTIONS

A function definition can contain: input arguments, numbers, parameters, 
constants, functions of parameter expressions including input arguments, unary 
and binary operators.

PRECEDENCE LEVEL SYMBOL DESCRIPTION

1 () {} . Grouping, Lists, Scope

2 ^ Power

3 ! - + Unary: Logical Not, Minus, Plus

4 [] Unit

5 * / Multiplication, Division

6 + - Binary: Addition, Subtraction

7 < <= > >= Comparisons: Less-Than, Less-Than or 
Equal, More-Than, More-Than or Equal

8 == != Comparisons: Equal, Not Equal

9 && Logical And

10 || Logical Or

11 , Element Separator in Lists
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Appendix D—File Formats

COMSOL File Formats

The COMSOL Model file type, with the extension .mph, is the default file type 
containing the entire model tree. The file contains both binary and text data. The 
mesh and solution data are stored as binary data, while all other information is 
stored as plain text.
Files with the extension .mph also contain an application that can be run in 
COMSOL Multiphysics, the COMSOL client for Windows®, or through a web 
browser. See the COMSOL Multiphysics Reference Manual and the Application 
Builder Reference Manual for more information.
The COMSOL binary and text file types, with the extension .mphbin and 
.mphtxt, respectively, contain either geometry objects or mesh objects which can 
be imported directly to the Geometry or Mesh branches in the model tree.
The Physics Builder file type, with the extension .mphphb, contains one or more 
physics interfaces that you can access from the Model Wizard. See the Physics 
Builder Manual, for more information.
See “Supported External File Formats” for more information about all the other 
formats supported by COMSOL.

Supported External Fi le Formats

CAD
The CAD Import Module, Design Module and LiveLink products for CAD allow 
for import of a range of industry-standard CAD file types. Additional file types are 
available through the bidirectional functionality of the LiveLink products for CAD 
as well as with the File Import for CATIA® V5 add-on.

FILE TYPE EXTENSION READ WRITE

COMSOL Model and Application .mph Yes Yes

Binary Data .mphbin Yes Yes

Text Data .mphtxt Yes Yes

Physics Builder .mphphb Yes Yes
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The DXF (2D), VRML (3D), and STL (3D) file types are available for import with 
COMSOL Multiphysics and don’t require any add-on products. Unless noted 
otherwise in the table below, import of the listed file types is available on all by 
COMSOL supported versions of Linux®, Mac OS X, and Windows® operating 
systems.

FILE TYPE EXTENSION READ WRITE

AutoCAD®1,2,3 .dwg Yes Yes9

Inventor®1,2,3 .ipt, .iam Yes Yes9

NX®1,4 .prt Yes No

PTC® Creo® Parametric™1,3 .prt, .asm Yes Yes9

PTC® Pro/ENGINEER®1,3 .prt, .asm Yes Yes9

Revit® Architecture3,5 .rvt Yes9 Yes9

Solid Edge®3,6 .par, .asm Yes9 Yes9

SOLIDWORKS®1,2,3 .sldprt, .sldasm Yes Yes9

DXF (3D1,2 and 2D) .dxf Yes Yes10

Parasolid®1 .x_t, .xmt_txt, .x_b, .xmt_bin Yes Yes

ACIS®1 .sat, .sab, .asat, .asab Yes Yes

STEP1 .step, .stp Yes No

IGES1 .iges, .igs Yes No

CATIA® V52,7 .CATPart, .CATProduct Yes No

VRML, v18 .vrml, .wrl Yes No
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ECAD
The ECAD Import Module allows for import of 2D layout files with automatic 
conversion to 3D CAD models. The Touchstone file type is used for exporting 
S-parameters, impedance, and admittance values from simultaneous port and 
frequency sweeps. The SPICE Circuit Netlist file type is converted at import to a 
series of lumped circuit element nodes under an Electrical Circuit node.

STL8 .stl Yes Yes
1Requires one of the LiveLink™ products for AutoCAD®, Revit®, PTC® Creo® Parametric™, 
Inventor®, PTC® Pro/ENGINEER®, Solid Edge®, SOLIDWORKS®; or the CAD Import Module; 
or the Design Module
2Import supported on Windows® operating systems only
3Synchronization of files between COMSOL and a linked CAD program supported on 
Windows® 7, 8, and 8.1 operating systems only
4Import supported on Windows® and Linux operating systems only
5Requires LiveLink™ for Revit®

6Requires LiveLink™ for Solid Edge®

7Requires the CAD Import Module (or the Design Module, or one of the LiveLink™ products 
for AutoCAD®, PTC® Creo® Parametric™, Inventor®, PTC Pro/ENGINEER®, Solid Edge®, or 
SOLIDWORKS®) and the File Import for CATIA® V5
8Limited to a single geometric domain
9From/To file using linked CAD package provided the original CAD geometry is created in the 
CAD package
10Writing to file is supported for 2D geometry only

FILE TYPE EXTENSION READ WRITE

NETEX-G1 .asc Yes No

ODB++1 .zip, .tar, .tgz, .tar.gz Yes No

ODB++(X)1 .xml Yes No

GDS1 .gds Yes No

Touchstone2 .s2p, .s3p, .s4p, ... No Yes

SPICE Circuit Netlist3 .cir Yes No
1Requires the ECAD Import Module
2Requires one of the AC/DC, RF, MEMS, or Wave Optics Modules
3Requires one of the AC/DC, RF, MEMS, Plasma, or Semiconductor Modules

FILE TYPE EXTENSION READ WRITE
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MATERIAL DATABASES

The Chemical Reaction Engineering Module can read CHEMKIN® files to 
simulate complex chemical reactions in the gas phase. The Plasma Module can 
read LXCAT files for sets of electron impact collision cross sections.

MESH

The NASTRAN® Bulk Data file types are used to import a volumetric mesh. The 
VRML and STL file types are used to import a triangular surface mesh, and cannot 
be used for creating a volumetric mesh. If imported as a Geometry, VRML and 
STL files can be used as a basis for creating a volumetric mesh for a single 
geometric domain.

IMAGES AND MOVIES

Results visualization can be exported to a number of common image file types, see 
the table below. Images can also be read and used as interpolation functions for 
physics modeling. Animations can be exported to one of the Animated GIF, 
Adobe® Flash®, and AVI file types.

FILE TYPE EXTENSION READ WRITE

CHEMKIN®1 .dat, .txt, .inp3 Yes No

CAPE-OPEN1 (direct connection) n/a n/a n/a

LXCAT file2 .lxcat, .txt Yes No
1Requires the Chemical Reaction Engineering Module
2Requires the Plasma Module
3Any extension is allowed; these are the most common extensions

FILE TYPE EXTENSION READ WRITE

NASTRAN® Bulk Data .nas, .bdf, .nastran, .dat Yes Yes

VRML, v1 .vrml, .wrl Yes No

STL .stl Yes Yes

FILE TYPE EXTENSION READ WRITE

JPEG .jpg, .jpeg Yes Yes

PNG .png Yes Yes

BMP .bmp Yes Yes

TIFF .tif, .tiff No Yes

GIF .gif Yes Yes
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PROGRAMMING LANGUAGES AND SPREADSHEET

Model files for Java® are editable script files, with the extension .java, that contain 
sequences of COMSOL commands as Java® code. Edit the files in a text editor to 
add additional commands. You can compile these Java® files into Java® Class files, 
with the extension .class, and run them as separate applications.
Model files for MATLAB® are editable script files (M-files), similar to the model 
files for Java®, for use with MATLAB®. These model files, which have the 
extension .m, contain a sequence of COMSOL commands as a MATLAB® M-file. 
You can run the model files in MATLAB® like any other M-file scripts. It is also 
possible to edit the files in a text editor to include additional COMSOL 
commands or general MATLAB® commands. Running model files in the M-file 
format requires the COMSOL LiveLink™ for MATLAB®.

NUMERICAL AND INTERPOLATION DATA FORMATS

The grid, sectionwise, and spreadsheet file types can be read for defining 
interpolation functions. The sectionwise and spreadsheet file types can 

EPS (1D graphs only) .eps No Yes

Animated GIF .gif No Yes

Adobe® Flash® .swf No Yes

AVI1 .avi No Yes
1Available for Windows® only

FILE TYPE EXTENSION READ WRITE

MATLAB®: model file for MATLAB® .m No Yes

MATLAB®: Function1 .m Yes No

Java®: model file for Java® .java No Yes

Java®: compiled model file for Java® .class Yes No

C: Function .dll3, .so4, .dylib5 Yes No

Excel®2 .xlsx Yes Yes
1Requires LiveLink™ for MATLAB®

2Requires LiveLink™ for Excel®, available for Windows® only
3Available for Windows® only
4Available for Linux® only
5Available for OS X only

FILE TYPE EXTENSION READ WRITE
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furthermore be read and used for defining interpolation curves and written for 
exporting results. In addition, tables can be copy-pasted on spreadsheet format.
Parameters and variables can be imported and exported to the plain text, 
comma-separated values, or data file types.
The continuous and discrete color table text file types are used for user-defined 
color tables for results visualization.
Digital elevation model (DEM) files can be read and used as a parametric surface 
for defining a geometry.

FILE TYPE EXTENSION READ WRITE

Copy and paste spreadsheet format n/a Yes Yes

Excel® spreadsheet1 .xlsx Yes Yes

Table .txt, .csv, .dat Yes Yes

Grid .txt Yes Yes

Sectionwise .txt, .csv, .dat Yes Yes

Spreadsheet .txt, .csv, .dat Yes Yes

Parameters .txt, .csv, .dat Yes Yes

Variables .txt, .csv, .dat Yes Yes

Continuous and Discrete color table .txt Yes No

Point data for Cut Point data sets .txt Yes No

DEM .dem Yes No
1Requires LiveLink™ for Excel®, available for Windows® only
174 | 



Appendix E—Connecting with LiveLink™ Add-Ons

The following table shows the options to start COMSOL and the different linked 
partner software using the LiveLink add-ons.

1When you open a COMSOL model from Excel®, a COMSOL model window starts and a link is 
established automatically. The COMSOL model window is an output window that displays 
geometry, mesh, and results.

COMSOL® 
Software

Can Start COMSOL 
from Partner Software

Can Start Partner Software 
from COMSOL

Can Connect 
Running Sessions

LiveLink™ 

for Excel®
Yes1 Yes2 No

LiveLink™
for MATLAB®

Yes3 Yes4 Yes5

LiveLink™ 

for AutoCad®

No No Yes

LiveLink™ 

for Revit®
No No Yes

LiveLink™ 

for PTC®Creo® 

Parametric™

No No Yes

LiveLink™ 

for Inventor®

- Bidirectional 
Mode

No No Yes

- One Window 
Mode

Yes No No

LiveLink™ 

for PTC® 

Pro/ENGINEER®

No No Yes

LiveLink™ 

for Solid Edge®

No No Yes

LiveLink™ 

for SOLIDWORKS®

- Bidirectional 
Mode

No No Yes

- One Window 
Mode

Yes No No
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2A COMSOL model that includes a table reference to an Excel® spreadsheet automatically starts 
an Excel® process in the background when the model is run in COMSOL Desktop environment.
3 You can start a COMSOL Multiphysics Server from a MATLAB® session using the system 
command and then connect to it using mphstart in the MATLAB® command prompt.
4The “COMSOL 5.2 with MATLAB®” desktop shortcut starts a COMSOL Multiphysics Server 
and MATLAB®, then connects them automatically. When you run a COMSOL model in the 
COMSOL Desktop interface that includes a MATLAB® function (Global Definitions>Functions), a 
MATLAB® engine and connection is started automatically.
5You can connect a MATLAB® session to a running COMSOL Multiphysics Server using the 
COMSOL command mphstart in the MATLAB® command prompt.
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A AC/DC Module 54

accuracy

convergence analysis 47

recover option 44

Add Material window

busbar model 62

opening 35, 61

add-on modules

AC/DC 54

Application Libraries, and 26

CAD Import 136, 168

CFD 109

Chemical Reaction Engineering 171

ECAD Import 170

MEMS 102

physics list, and 31, 55

Plasma 171

Structural Mechanics 30, 40

study types, and 56

advanced study options 132

advanced topics 94

analysis

convergence 47

example, parametric sweep 51

application 11, 82

Application Builder 6, 8, 10, 11, 21, 82, 

155

Application Libraries

examples 26

file types 27

MPH-files 26

opening 26

Application Library Update 27

average temperature 126

B blank model, creating 13, 15

boundaries 68

adding to selection 70

variables scope 21

boundary condition 66

automatically defined 40

boundary load 39

busbar, setting 66

electric current 66, 69

fixed constraint 38

free 37

ground, electrical 71

heat transfer 66

insulating 68

material interface 40

settings window, and 8

boundary load 40

boundary section

context menu, and 67

boundary selection, busbar model 68

Build All button

geometry 59

meshes 40, 73

built-in

constants, functions, and variables 22

materials 35, 61

variables 77

button object 85

C CAD Import Module 136, 168

cancel button 10

CFD Module 109

Chemical Reaction Engineering Module 

171

cloud computing 132

Cluster Computing node 132

Cluster Sweep node 132
Index | 177



command sequence 88

Compact MPH-files 27

component coupling 126

Component node, adding materials 62

computing studies 51

COMSOL Client 11

COMSOL Desktop environment

customizing 23

on Linux 17

on OS X 17

overview 6

COMSOL Multiphysics 11

native CAD format 33

opening 31

COMSOL Server 11

constants

mathematical and physical types 22

context menu

domain and boundary sections 67

contextual tab 16

convergence analysis 47, 52

Convergence plot 9, 73

cooling

air stream 53

natural convection 57

coupling operator 126

Create Selection button 105

custom studies 56

customized desktop 23

D data sets, defined 18

default feature 66

Definitions node 29

degrees of freedom 47, 52

derivatives 23

Derived Values

defined 18

Global Evaluation 52

Volume Maximum 47, 51, 81

Direct solver 42

DirectX 12

discretize 40

documentation, models 26

domain level 67

domain section

context menu, and 67

domains

materials 64

physics 38

remove from selection 64

variables scope 21

dynamic help 10

E ECAD Import Module 170

edges

variables scope 21

Editor Templates window 87

eigenfrequency analysis 18

Electric Currents interface

defining boundary conditions 67

multiphysics, and 56, 71

overview 66

electric potential 54

physics node 69

voltage drop, parameter 57

electrical heating 53

equation

built-in 66

user-defined 45

error message, insufficient memory 42

evaluating

volume maximum 48, 79, 81

von Mises stress 48

example

advanced, electrical heating 53

basic, structural mechanics 30

Excel® 174

Export node, defined 18

exporting images 81

expressions
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Boolean 46

manual entry 48, 57

replacing 46, 77, 79

units, specifying 48

user-defined 45

External Process window 10

F finite element

mesh 40

preconditioning 51

sparse matrix 42

tetrahedrons 40

Fixed Constraint node 38

Floating Network License 132

Form editor 10, 85

form objects 82

form union, geometry 59

frequency response 19

frequency-domain study 18

Full MPH-files 27

functions

advanced topics 94

built-in 22

mathematical 23

ppr(), recover option 48

scope 57

Functions node 57

G geometric dimensions

parameters, and 20

parametric sweep 57

geometry

building 57

CAD format 32

importing 32

in Application Libraries 58

loading from file 57, 58

parameterized 20, 57, 59

settings window 8

Geometry node 28

Global Definitions node 17

functions 57

parameters 57

scope 21, 57

variables 20

global parameters 20, 36, 49

graphics

rendering and hardware 12

graphics object 84, 86

Graphics toolbar

default view button 38, 45, 71, 78

image snapshot button 82

zoom extents button 60, 75

Graphics window 9

geometry, and 34

plot 43

rotate geometry 38, 74, 76

selecting boundary 38, 39, 71

using 34, 61

zoom box 39

Ground, boundary condition 70

H Heat Transfer in Solids interface

defining boundary conditions 67

multiphysics, and 56, 71

overview 66

Heat Transfer Module 109

Help window

defined 10

opening 17

high performance computing 132

Home tab 15

HPC 132

hybrid parallelism 134

I Image Snapshot button 82

images, creating thumbnails 81

importing geometry 32, 33

infinite elements 29

information windows 9
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initial conditions 8

Initial Values node

Electric Currents interface 67

Heat Transfer in Solids interface 67

Solid Mechanics interface 37

input fields 83

Insert Object menu 87

Isosurface plot 74

iterative solver

multigrid 51

preconditioning 51

J Java 172

Java-file 29

Joule heating

equations 66

multiphysics coupling 71

Joule Heating multiphysics interface 55

L Laminar Flow interface 113

Linux version 17

LiveLink™ add-ons 174

Log window 9, 43

LU factorization 42

M Material Browser

defined 10

material contents section 35, 63

material interface

mechanical contact 40

visualization accuracy 44

materials

copper 53

domains, assigning 63

model tree 28

settings window 8

steel 35, 45

titanium alloy 53

Materials node 35, 61

mathematical constants and functions 

22

MATLAB® 172

matrix 42

matrix equation system 42

Max/Min Volume plot 48

Maximum and minimum values table 80

memory requirements (RAM) 41

MEMS Module

thermal expansion, and 102

mesh

convergence analysis, and 47

density 49

finite element 40

model tree, and 29

parameterizing 49, 71

physics-controlled, default 71

refining 49

settings 40

unstructured tetrahedral 71

user-controlled 50, 72

mesh element size

parameters, defining 20, 72

settings 40

Message Passing Interface 134

Messages window 9, 43

method 91

Method editor 10, 91

M-file 29

modal tab 16

Model Builder 82

defined 10

example 28

expanding sections 66

geometry import 33

node sequence example 37

the ribbon, and 16

model history 29

model tree

building 17

defined 57
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example 28

geometry 28

Global Definitions node 17, 36, 57

Materials node 28, 35

Model Builder, and 10

nodes, and 17

Results node 18

root node 17

Study node 18, 29

the ribbon, and 16

Model Wizard

adding physics 18, 31, 55

Component node, and 18

creating a new model 13

custom studies 32, 56

opening 31, 54

preset studies 32, 56

space dimension 31, 55

study 18, 56

models

defining 10

discretization 40

documentation 26

saving 61

structural mechanics 30

symmetry 76

workflow 28

MPH-files

full and compact 27

saving 61, 82

MPI 134

multicore processors 132

multiphysics models 53

Multiphysics node 66, 67, 71, 104

multiphysics phenomena 53

Multislice plot 74

N New Form wizard 82

nodes 17

default feature 37

reordering 29

O OpenGL 12

OS X version 17

P parallel computing 132

Parameter settings

expression 49

name 49

parameters 20, 84

defining 49, 57

editing 59

expression 20

global 20

meshes, and 49

range of values 51

scope 57

using, referencing 69

Parameters node 57, 94

parametric study 57

parametric sweep 20

example 50

meshes, and 49

range, defining 51

Perfectly Matched Layer (PML) 29

physics

adding 55

boundary conditions 66

electromagnetic heating 55

heat transfer 55

Joule heating 53, 66

laminar flow 113

model tree, and 28

physics interface 13

Electric Currents 56

Heat Transfer in Solids 56

Joule Heating 55

Laminar Flow 113

Solid Mechanics 31

Plasma Module 171
Index | 181



Plot Group 18

3D, adding 45

plots 45

expression, user-defined 45

max/min volume 48

model tree, and 29

regenerating 45, 49

surface 43, 46

windows 9

points, variables scope 21

polynomial functions 40

polynomial-preserving recovery 48

preconditioning 51

preferences 12

preset studies 56

principal stress 109

program code

model file for Java 29

model M-file 29

progress bar 10

Progress window 9

Q Quick Access Toolbar 8, 16

R Record Code 92

renaming plot groups 46

rendering options 12

reports, defined 18

reserved name 22

resolution of curvature, mesh 72

results

color table range 74, 77

derived values 47, 51, 81

displaying 43

quality, accuracy 44

recover option 44, 46, 48

surface settings, modify 74

units, changing 43

Results node

3D plot group 48, 76

busbar defaults 74

subnodes 18

surface node, adding 76

ribbon

Add Material 35, 65, 112

Build All 60

Build Mesh 73

Compute 51, 107, 122

defined 8, 15

example 6

importing geometry 33

Model Builder, and 16

Physics tab 38, 104

Windows 10, 43, 139

Work Plane 137

root node

default units, and 125

defined 17

model thumbnails, and 81

Model Wizard, and 31

running simulations 73

S saving files 61, 82

scope

global definitions 57

parameters and variables 21

parameters and variables, defined 20

variable name 22

Select Study window 15

Selection 105

Selection List window 10, 139

selection of multiple boundaries 105

Settings windows 8, 17

shared memory parallelism 132

simulation, running 73

Software Rendering 12

Solid Mechanics interface 31

add-on modules, and 102

solvers

configurations 42, 51
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default settings 41

default settings, changing 42

direct 42

iterative 50, 51

memory requirements 41

memory-limited settings 42

stationary 41, 51

using 41

space dimension 13

sparse matrix equation system 42

Stationary study 32, 41

steady-state study 18

structural analysis 30

structural displacement field 40

structural mechanics

design 47

plastic deformation 45

stresses and strains 53, 63

von Mises stress 43

Structural Mechanics Module

application library 30

mechanical contact, and 40

thermal expansion, and 102

studies

computing solutions 51, 73

defining 41

example, multigrid iterative 51

example, stationary 41

model tree, and 29

preset 56

types 18

Study node 18

solution sequence 73

Surface plot

busbar results 74

color table range 77

deformation 43

electrical current density 76

replace expression 77

settings 46

updating 75, 77

T table

Maximum and minimum 80

Table window 10

graph plot 52

wrench results 48

Tables node 18

tables, evaluating 52

temperature 74, 123

temperature, average 126

Test Application 86

tetrahedron, polynomial functions 40

thermal expansion 53, 63

thumbnail image 81

time-dependent study 18

torque, applied 30

U unit, changing 43, 108

user interface

COMSOL Desktop 6

overview 6

user-controlled mesh 50

V variables

advanced topics 94

built-in 22

example, built-in 52

expression 21

scope 57

scope, limit 21

Variables node 20, 57

visualization 9

accuracy 44

color table 74, 77

Volume Maximum, evaluating 48, 79, 81

von Mises stress 43, 109

W Windows list 43, 139

wizard

New Form 82
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workflow 26

Y yield stress 30, 45

Z zoom 123

Zoom Extents command 89
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